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The LabVIEW Communications VI Reference Manual describes
networking and interapplication communications with LabVIEW.

This manual is a supplement to your LabVIEW user manual, and
assumes that you are familiar with that material. You should also know
how to operate LabVIEW, and your computer and operating system.

Organization of This Manual

This manual is organized as follows:

© National Instruments Corporation

Chapter 1, Communication Applications in LabVIEW, is an
overview of the way LabVIEW handles networking and
interapplication communications.

Chapter 2, TCP Vls, discusses Internet Protocol (IP), Transmission
Control Protocol (TCP), and internet addresses, and describes the
LabVIEW TCP VlIs.

Chapter 3, UDP VlIs, describes a set of VIs that you can use with
User Datagram Protocol (UDP), a protocol in the TCP/IP suite for
communicating across a single network or an interconnected set of
networks.

Chapter 4, DDE VlIs, describes the LabVIEW VIs for Dynamic
Data Exchange (DDE) for Windows 3.1, Windows 95, and
Windows NT.

Chapter 5, OLE Automation VIs, discusses the LabVIEW Vs for
OLE Automation, a feature which allows LabVIEW to access
objects exposed by automation servers in the system.

Chapter 6, Apple Event Vls, discusses the LabVIEW VIs for
interapplication communication (IAC), a feature of Apple
Macintosh system software version 7 by which Macintosh
applications can communicate with each other.

Chapter 7, Program to Program Communication VIs, describes the
LabVIEW VIs for Program to Program Communication (PPC), a
low-level form of Apple IAC by which Macintosh applications
send and receive blocks of data.

Xi LabVIEW Communications VI Reference Manual



About This Manual

* Appendix A, Communications Common Questions, lists answers to
questions frequently asked by LabVIEW users.

* Appendix B, Error Codes, lists the error codes returned by
LabVIEW functions, including the name and description of each
code.

* Appendix C, Customer Communication, contains forms you can
use to request help from National Instruments or to comment on
our products and manuals.

*  The Glossary contains an alphabetical list of terms used in this
manual and a description of each.

*  The Index contains an alphabetical list of key terms and topics in
this manual, including the page where each one can be found.

Conventions Used in This Manual

bold

italic

bold italic

monospace

italic
monospace

< >

»

The following conventions are used in this manual:

Bold text denotes parameters, menu items, return values, dialog box
buttons, or options.

Italic text denotes emphasis, a cross reference, or an introduction to a
key concept.

Bold italic text denotes a note, caution, or warning.

Text in this font denotes text or characters that you should literally
enter from the keyboard. Sections of code, programming examples, and
syntax examples also appear in this font. This font also is used for the
proper names of disk drives, paths, directories, programs, subprograms,
subroutines, device names, variables, filenames, and extensions, and
for statements and comments taken from program code.

Italic text in this font denotes that you must supply the appropriate
words or values in the place of these items.

Angle brackets enclose the name of a key on the keyboard—for
example, <Shift>.

A hyphen between two or more key names enclosed in angle brackets
denotes that you should simultaneously press the named keys—for
example, <Ctrl-Alt-Delete>.

The » symbol leads you through nested menu items and dialog box
options to a final action. The sequence File»Page Setup»Options»
Substitute Fonts directs you to pull down the File menu, select the Page

LabVIEW Communications VI Reference Manual Xii © National Instruments Corporation
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Setup item, select Options, and finally select the Substitute Fonts
option from the last dialog box.

paths Paths in this manual are denoted using backslashes (\) to separate drive
names, directories, and files, as in
drivename\dirlname\dir2name\myfile.

L9 <

Warning: This icon to the left of bold italicized text denotes a warning, which alerts
you to the possibility of damage to you or your equipment.

Caution: This icon to the left of bold italicized text denotes a caution, which alerts
you to the possibility of data loss or a system crash.

Note: This icon to the left of bold italicized text denotes a note, which alerts you
to important information.

Data Types Each VI description gives a data type picture for each control and
indicator, as illustrated in the following table:

Control

Indicator

Data Type

Double-precision floating-point
number

Unsigned 32-bit integer

Unsigned 16-bit integer

Signed 32-bit integer

Signed 16-Bit integer

Boolean

String

Refnum

Path

JHHEEEEER E
JHEEEEEEE E

Cluster

.

gn.

Cluster of clusters or
Cluster of arrays

© National Instruments Corporation
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Control Indicator Data Type

{[x16]] | [118] | Array of Signed 16-bit integers*

[[vs]] | [va] | Array of Unsigned 8-bit
integers*

[[ab<]] | [abc] | String Array*

{[oBL]] | [pBL] | Array of double-precision
floating-point numbers*

{[=0:]] | [=0s] Array of clusters*

* The dimension of an array is indicated by the thickness of
the array bracket. For instance, a 2D array bracket is slightly
heavier than a 1D array bracket, and lighter than a 3D array

bracket.

Abbreviations, acronyms, metric prefixes, mnemonics, symbols, and
terms are listed in the Glossary.

Related Documentation

The following documents contain information that you may find
helpful as you read this manual:

LabVIEW Tutorial
LabVIEW User Manual
LabVIEW Function Reference Manual

Apple Event Registry, by Apple Computer Inc., 1991, available
from APDA, P.O. Box 319, Buffalo, New York

Inside Macintosh, Volume VI, by Apple Computer Inc., 1991
Microsoft Excel User’s Guide 2, 1992-1993

LabVIEW Communications VI Reference Manual
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Customer Communication

National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with
our products, and we want to help if you have problems with them. To
make it easy for you to contact us, this manual contains comment and
configuration forms for you to complete. These forms are in the
Appendix C, Customer Communication, at the end of this manual.
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Communication Applications
in LabVIEW

This chapter is an overview of the way LabVIEW handles networking
and interapplication communications.

For the purpose of this discussion, networking refers to communication
between multiple processes. The processes can optionally run on
separate computers. This communication usually occurs over a
hardware network, such as ethernet or LocalTalk.

One main use for networking in software applications is to allow one
or more applications to use the services of another application. For
example, the application providing services (the server) could be either
a data collection application running on a dedicated computer, or a
database program providing information for other applications.

The purpose of this discussion is to introduce you to the terminology
used in networking and communication applications, and to give you
an overview of how to program networked applications.

Communication Protocols

For communication between processes to work, the processes must use
a common communications language, referred to as a protocol.

A communication protocol lets you specify the data that you want to
send or receive and the location of the destination or source, without
having to worry about how the data gets there. The protocol translates
your commands into data that network drivers can accept. The network
drivers then take care of transferring data across the network as
appropriate.

Several networking protocols have emerged as accepted standards for
communications. In general, one protocol is not compatible with a
different protocol. Thus, in communication applications, one of the
first things you must do is decide which protocol to use. If you want to
communicate with an existing, off the shelf application, then you have
to work within the protocols supported by that application.
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When you are actually writing the application, you have more
flexibility in choosing a protocol. Factors that affect your protocol
choice include the type of machines the processes will run on, the kind
of hardware network you have available, and the complexity of the
communication that your application will need.

Several protocols are built into LabVIEW, some of which are specific
to a type of computer. LabVIEW uses the following protocols to
communicate between computers:

e TCP-Available on all computers
e UDP-Available on all computers

e DDE-Available on the PC, for communication between Windows
applications

e OLE-Available for use with Windows 95 and Windows NT

* AppleEvents—Available on the Macintosh, for sending messages
between Macintosh applications

*  PPC-Available on the Macintosh, for sending and receiving data
between Macintosh applications

Each protocol is different, especially in the way they refer to the
network location of a remote application. They are incompatible with
each other, so if you want to communicate between a Macintosh and a
PC, you must use a protocol compatible with both, such as TCP.

Other communication options provided by LabVIEW include:

* System Exec VI, which allows you to execute a system level
command. There are actually two System Exec VIs, one for use
with all versions of Windows, the other with Sun and HP-UX.

* Named Pipes, available on UNIX only
e HiQ®, available on the Macintosh only

You can also find information about these LabVIEW features online by
using the LabVIEW Help window (Help»Show Help). When you place
the cursor on a VI icon, the wiring diagram and parameter names for
that VI appear in the Help window. You can also find information for
front panel controls or indicators by placing the cursor over the control
or indicator with the Help window open. For more information on the
LabVIEW Help window, refer to the Getting Help section in Chapter 2,
Creating VIs, of the LabVIEW User Manual.
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In addition to the Help window, LabVIEW has more extensive online
# information available. To access this information, select Help»Online
Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online
description. You can also access this information by pressing the
button shown to the left, which is located at the bottom of LabVIEW’s
Help window.

File Sharing vs Communication Protocols

Before you get too deeply involved in communication protocols,
consider whether another approach is more appropriate for your
application. For instance, consider an application where a dedicated
system acquires data and you want the data recorded on a different
computer.

You could write an application that uses networking protocols to send
data from the acquisition computer to the data repository machine,
where a separate application collects the data and stores it on disk.

A simpler method is to use the filesharing capabilities available on
most networked computers. With filesharing, drivers that are part of
the operating system let you connect to other machines. The remote
machine’s disk storage is treated as an extension of your own disk
storage. Once you connect two systems, filesharing usually makes this
connection transparent, so that any application can write to the remote
disk as if connected locally.

Filesharing is frequently the simplest method for transferring data
between machines.

Client/Server Model

The client/server model is a common model for networked
applications. In the client/server model, one set of processes (clients)
request services from another set of processes (servers).

For example, in your application you could set up a dedicated computer
for acquiring measurements from the real world. The computer acts as
a server when it provides data to other computers on request. It acts as
a client when it requests another application, such as a database
program, to record the data that it acquires.
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In LabVIEW, you can use client and server applications with all
protocols except Macintosh AppleEvents. You can use AppleEvents to
send commands to other applications. You cannot set up a command
server in LabVIEW using AppleEvents. If you need server capabilities
on the Macintosh, use either TCP, UDP or PPC.

A General Model for a Client
The following block diagram shows what a simplified model for a
client looks like in LabVIEW:

QOpen Exec Close
Conn E“"" Crd [ Conn @
to Srur an Srur 10 SFUF b

In the preceding diagram, LabVIEW first opens a connection to a
server. It then sends a command to the server, gets a response back, and
closes the connection to the server. Finally, it reports any errors that
occurred during the communication process.

For higher performance, you can process multiple commands once the
connection is open. After the commands are executed, you can close
the connection.

This basic block diagram structure serves as a model and is used
elsewhere in this manual to demonstrate how to implement a given
protocol in LabVIEW.
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A General Model for a Server

The following block diagram shows a simplified model for a server in
LabVIEW:

Initialize

|1'f error, don't cuntinuel

Server : - [Results
“F statuz | f i =

Return| |

In the preceding diagram, LabVIEW first initializes the server. If the
initialization is successful, LabVIEW goes into a loop, where it waits
for a connection. Once the connection is made, LabVIEW waits to
receive a command. LabVIEW executes the command and returns the
results. The connection is then closed. LabVIEW repeats this entire
process until it is shut down locally by pressing a stop button on the
front panel, or remotely by sending a command to shut the VI down.

This VI does not report errors. It may send back a response indicating
that a command is invalid, but it does not display a dialog when an
error occurs. Because a server might be unattended, consider carefully
how the server should handle errors. You probably do not want a dialog
box to be displayed, because that requires user interaction at the server
(someone would have to press the OK button). However, you might
want LabVIEW to write a log of transactions and errors to a file or a
string.

You can increase performance by allowing the connection to stay open,
so that you can receive multiple commands, but this blocks others
clients from connecting until the current client disconnects. If the
protocol supports multiple simultaneous connections, you can
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restructure LabVIEW to handle multiple clients simultaneously, as
shown in the following diagram.

weait for connect'ions|

don't continue Wait

for a |-
Inikialize, Conn error out]

server LS Tovatus |1 T i

keep going m o] KEBD QOING

Get new connections [y
one at a time from

the queue. This could
be changed to get all

Mo error -

N =tay
queued connections ted Close all
Enpty when queried. Conneste
[o] > i
True
= (=53 | I ﬁhUt
[ ] o = | Hwait |1 e filReturn S:VUE::V
S fCDr:n: Crad | [Results] b [ status | i

The preceding diagram uses LabVIEW’s multitasking capabilities to
run two loops simultaneously. One loop continuously waits for a
connection. When a connection is received, it is added to a queue. The
other loop checks each of the open connections and executes any
commands that have been received. If an error occurs on one of the
connections, the connection is disconnected. When the user aborts the
server, all open connections are closed. This basic block diagram
structure is a model which is used elsewhere in this manual to
demonstrate how to implement a given protocol in LabVIEW.

TCP/IP (all platforms)

TCP/IP is a suite of communication protocols, originally developed for
the Defense Advanced Research Projects Agency (DARPA). Since its
development, it has become widely accepted, and is available on a
number of computer systems.
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The name TCP/IP comes from two of the best known protocols of the
suite, the Transmission Control Protocol (TCP) and the Internet
Protocol (IP). TCP, IP, and the User Datagram Protocol (UDP) are the
basic tools for network communication.

TCP/IP enables communication over single networks or multiple
interconnected networks, which are known as an internetwork or
internet. The individual networks can be separated by great
geographical distances. TCP/IP routes data from one network or
internet computer to another. Because TCP/IP is available on most
computers, it can transfer information between diverse systems.

Internet Protocol (IP) transmits data across the network. This low level
protocol takes data of a limited size and sends it as a datagram across
the network. IP is rarely used directly by applications, because it does
not guarantee that the data will arrive at the other end. Also, when you
send several datagrams they sometimes arrive out of order, or are
delivered multiple times, depending on how the network transfer
occurs. UDP, which is built on top of IP, has similar problems.

TCP is a higher level protocol that uses IP to transfer data. TCP breaks
data into components that IP can manage. It also provides error

detection and ensures that data arrives in order without duplication. For
these reasons, TCP is usually the best choice for network applications.

Internet Addresses

Each host on an IP network has a unique 32-bit internet address. This
address identifies the network on the internet to which the host is
attached, and the specific computer on that network. You use this
address to identify the sender or receiver of data. IP places the address
in the datagram headers, so that each datagram is routed correctly.

One way of describing this 32-bit address is the IP dotted decimal
notation. This divides the 32-bit address into four 8-bit numbers. The
address is written as the four integers, separated by decimal points. For
example, the 32-bit address

10000100 00001101 00000010 00011110
is written in dotted decimal notation as

132.13.2.30
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Another way of using the 32-bit address is by names that are mapped
to the IP address. Network drivers usually perform this mapping by
consulting a local hosts file that contains name to address mappings, or
consulting a larger database using the Domain Name System to query
other computer systems for the address for a given name. Your network
configuration dictates the exact mechanism for this process, which is
known as hostname resolution.

Before you can use TCP/IP, you need to make sure that you have the
right setup. This setup varies, depending on the computer you use.

Setup for Your System

Sun and HP-UX

TCP/IP support is built-in. Assuming your network is configured
properly, no additional setup for LabVIEW is necessary.

Macintosh

TCP/IP is built in to Macintosh operating system version 7.5. To use
TCP/IP with an earlier system, you need to install the MacTCP driver
software, available from the Apple Programmer Developer Association
(APDA). You can contact APDA at (800) 282-2732 for information on
licensing the MacTCP driver.

Windows 3.x

To use TCP/IP, you must install an ethernet board along with its
low-level driver. In addition, you must purchase and install TCP/IP
software that includes a Windows Sockets (WinSock) DLL conforming
to standard 1.1. WinSock is a standard interface that enables
application communication with a variety of network drivers. Several
vendors provide network software that includes the WinSock DLL.
Install the ethernet board, the board drivers, and the WinSock DLL
according to the software vendor instructions.

Several vendors supply WinSock drivers that work with a number of
boards. You can contact the vendor of your board to inquire if they
offer a WinSock DLL you can use with the board. Install the WinSock
DLL according to vendor instructions.
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National Instruments has tested a number of WinSock DLLs to verify
which work correctly. These tests showed that many DLLs do not fully
comply with the standard, so you may want to try a demo version of a
DLL before you buy the real version. You can usually obtain a demo
version from the manufacturer. Most demo versions are fully
functional, but they expire after a certain amount of time.

If you have access to the internet, several of these demos are available
by anonymous ftp from sunsite.unc.edu. in the directory /pub/
micro/pc-stuff/ms-windows/winsock/packages. Refer

to your LabVIEW Release Notes for a detailed list of WinSock DLLs
tested by National Instruments.

Windows 95 and Windows NT

TCP support is built-in to Windows NT. You do not need to use a
third-party DLL to communicate using TCP.

LabVIEW and TCP/IP

TCP versus UDP

You can use the TCP/IP suite of protocols with LabVIEW on all
platforms. LabVIEW has a set of TCP and UDP VIs that you can use
to create client or server VIs.

If you are writing both the client and server, and your system can use
TCP/1P, then TCP is probably the best protocol to use because it is a

reliable, connection-based protocol. UDP is a connectionless protocol
with higher performance, but it does not ensure reliable transmission

of data.

TCP Client Example

QOpen
Conn
to Srur

The following discussion is a generalized description of how to use the
components of the Client block diagram model with the TCP protocol.

Use the TCP Open Connection VI to open a connection to a server. You
must specify the internet address of the server, as well as the port for
the server. The address identifies a computer on the network. The port
is an additional number that identifies a communication channel on the
computer that the server uses to listen for communication requests.
When you create a TCP server, you specify the port that you want the
server to use for communication.
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Exec
Crad
on Srur

Claze
Conn
to Srur

To execute a command on the server, use the TCP Write VI to send the
command to the server. You then use the TCP Read VI to read back
results from the server. With the TCP Read VI, you must specify the
number of characters you want to read. This can be awkward, because
the length of the response may vary. The server can have the same
problem with the command, because the length of a command can vary.

The following are several methods you can use to address varying
sized commands:

e Precede the command and the result with a fixed size parameter
that specifies the size of the command or result. In this case, read
the size parameter, and then read the number of characters
specified by the size. This option is efficient and flexible.

e Make each command and result a fixed size. When a command is
smaller than the size, you can pad it out to the fixed size.

¢ Follow each command and result with a specific terminating
character. To read the data, you then need to read data in small
chunks until you get the terminating character.

Use the TCP Close Connection VI to close the connection to the server.

Timeouts and Errors

The preceding section discussed communication protocol for the
server. When you design a network application consider carefully what
should happen if something fails. For example, if the server crashes,
how would each of the client VIs handle it?

One solution is to make sure that each VI has a timeout. This way, if
something fails to produce results, after a certain amount of time, the
client will continue execution. In continuing, the client can try to
reestablish execution, or it can report the error, and if necessary, shut
the client application down gracefully.

TCP Server Example

Initialize
Seryer

The following discussion explains how you can use TCP to fulfill each
component of the general server model.

No initialization is necessary with TCP, so this step can be left out.
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Use the TCP Listen VI to wait for a connection. You must specify the
port that will be used for communication. This port must be the same
port that the client will attempt to connect. For more information, see
the TCP Client Example section in this chapter.

If a connection is established, read from that port to retrieve a
command. As discussed in the TCP Client example, you must decide
the format for commands. If commands are preceded by a length field,
first read the length field, and then read the amount of data indicated
by the length field.

Execution of a command should be protocol independent, because it is
done on the local computer. When finished, pass the results to the next
stage, where they are transmitted to the client.

Use the TCP Write VI to return results. As discussed in the TCP Client
example, the data must be in a form that the client can accept.

Use the TCP Close Connection VI to close the connection.

This step can be left out with TCP, because everything is finished after
you close the connection.

TCP Server with Multiple Connections

TCP handles multiple connections easily. You can use the methods
described in the preceding section to implement the components of a
server with multiple connections.

DDE (Windows Only)

Dynamic Data Exchange (DDE) is a protocol for exchanging data
between Windows applications.

In TCP/IP communications, applications open a line of communication
and then transfer raw data. DDE works at a higher level, where
applications send messages to each other to exchange information. One
simple message is to send a command to another application. Most of
the other messages deal with transferring data, where the data is
referenced by name.
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A DDE client initiates a conversation with another application (a DDE
server) by sending a connect message. After establishing a connection,
the client can send commands to the server and change or request the
value of data that the server manages.

A client can request data from a server by a request or an advise. The
client uses a request to ask for the current value of the data. If a client
wants to monitor a value over a period of time, the client must request
to be advised of changes. By asking to be advised of data value, the
client establishes a link between the client and server through which
the server notifies the client when the data changes. The client can stop
monitoring the value of the data by telling the server to stop the advise
link.

When the DDE communication for a conversation is complete, the
client sends a close conversation message to the server.

DDE is most appropriate for communication with standard off the shelf
applications such as Microsoft Excel.

With LabVIEW you can create VIs that act as clients to other
applications (meaning they request or send data to other applications).
You can also create VIs that act as servers that provide named
information for access by other applications. As a server, LabVIEW
does not use connection-based communication. Instead, you provide
named information to other applications, which can then read or set the
values of that information by name.

Services, Topics, and Data Items

With TCP/IP, you identify the process you want to talk to by its
computer address and a port number. With DDE, you identify the
application you want to talk to by referencing the name of a service and
a topic. The server decides on arbitrary service and topic names. A
given server generally uses its application name for the service, but not
necessarily. That server can offer several topics that it is willing to
communicate. With Excel, for example, the topic might be the name of
a spreadsheet.

To communicate with a server, first find the names of the service and
topic that you want to discuss. Then open a conversation using these
two names to identify the server.

LabVIEW Communications VI Reference Manual 1-12 © National Instruments Corporation



Chapter 1 Communication Applications in LabVIEW

Unless you are going to send a command to the server, you usually
work with data items that the server is willing to talk about. You can
treat these as a list of variables that the server lets you manipulate. You
can change variables by name, supplying a new value for the variable.
Or, you can request the values of variables by name.

Examples of Client Communication with Excel

Each application that supports DDE has a different set of services,
topics, and data items that it can talk about. For example, two different
spreadsheet programs can take very different approaches to how they
specify spreadsheet cells. To find out what a given application
supports, consult the documentation that came with that application.

Microsoft Excel, a popular spreadsheet program for Windows, has
DDE support. You can use DDE to send commands to Excel. You can
also manipulate and read spreadsheet data by name. For more
information on how to use DDE with Excel, refer to the Microsoft
Excel User’s Guide 2.

With Excel, the service name is Excel. For the topic, you use the name
of an open document, such as spreadsheet document, or the word
System.

If you use the name System, you can request information about the
status of Excel, or send general commands to Excel (commands that are
not directed to a specific spreadsheet). For instance, for the topic
System, Excel will talk about items such as Status, which will have
a value of Busy if Excel is busy, or Ready if Excel is ready to execute
commands). Another, more useful data item you can use when the topic
is Status is Topics, which returns a list of topics Excel will talk
about, including all open spreadsheet documents and the System
topic.
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The following VI shows how you can use the Topics command in
LabVIEW. The value returned is a string containing the names of the
open spreadsheets and the work Excel.

ralue]

(=] DDE
CLOSE

Another way you can use the System topic with Excel is to instruct
Excel to open a specific document. To do this, you use the DDE
Execute.vi to send an Excel Macro to Excel that instructs Excel to open
the document, as shown in the following LabVIEW diagram:

ITDpiCSI

topic

OPER

itern
[OPENC'G NEXCELWDAT&.KLS™) ]l

DDE o] DDE
= 5
E+ELC CLOSE

topic

OPEHR

After you open a spreadsheet file, you can send commands to the
spreadsheet to read cell values. In this case, your topic is the
spreadsheet document name. The item is the name of a cell, a range of
cells, or a named section of a spreadsheet. For example, in the
following diagram LabVIEW can retrieve the value in the cell at row
one column one. It then acquires a sample from the specified channel,
and sends the resulting sample back to Excel.

LabVIEW Communications VI Reference Manual 1-14 © National Instruments Corporation



Chapter 1 Communication Applications in LabVIEW

Fead the desired channe] Send the channel's walue

to Excel
DE
o)
CLOSE]

Read 1 sample from
the specified channel
and convert it to a string

forn Excel

R1C2
3 [T

oS

POKE|

LabVIEW Vis as DDE Servers

You can create LabVIEW VIs that act as servers for data items. The
general concept is that a LabVIEW VI indicates that it is willing to
provide information regarding a specific service in topic. LabVIEW
can use any name for the service and topic name. It might specify the
service name to be the name of the application (LabVIEW), and the
topic name to be either the name of the Server VI, or a general
classification for the data it provides, such as Lab Data.

The Server VI then registers data items for a given service that it will
talk about. LabVIEW remembers the data names and their values, and
handles communication with other applications regarding the data.
When the server VI changes the value of data that is registered for DDE
communication, LabVIEW notifies any client applications that have
requested notification concerning that data. In the same way, if another
application sends a Poke message to change the value of a data item,
LabVIEW changes this value.

You cannot use the DDE Execute Command with a LabVIEW VI
acting as a server. If you want to send a command to a VI, you must
send the command using data items.

Also, notice that LabVIEW does not currently have anything like the
System topic that Excel provides. The LabVIEW application is not
itself a server to which you can send commands or request status
information. It is important to understand that LabVIEW VIs act as
servers and that at this time LabVIEW does not itself provide any
services to other applications.
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The following example shows how to create a DDE Server VI that
provides data to other client applications. In this case, the data is a
random number. You can easily replace the random number with real
world data from data acquisition boards or devices connected to the
computer by GPIB, VXI, or serial connections.

|wavef-:-rm char'tl |-:|e].a|=||

sebvice name

ITEH SERUER

SERUER ITEHM

The VIin the preceding diagram registers a server with LabVIEW. The
VI registers an item that it is willing to provide to clients. In the loop,
the VI periodically sets the value of the item. As mentioned earlier,
LabVIEW notifies other applications that data is available. When the
loop is complete, the VI finishes by unregistering the item and
unregistering the server.

The clients for this VI can be any applications that understand DDE,
including other LabVIEW VIs. The following diagram illustrates a
client to the VI shown in the previous diagram. It is important that the
service, topic, and item names are the same as the ones used by the
Server.
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Requesting Data versus Advising Data
The previous client example used the DDE Request VI in a loop to
retrieve data. With DDE Request, the data is retrieved immediately,
regardless of whether you have seen the data before. If the server and
the client do not loop at exactly the same rate, you can duplicate or miss
data.
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One way to avoid duplicating data is to use the DDE Advise VIs to
request notification of changes in the value of a data item. The
following diagram shows how you can implement this scheme:

wavetorm chart
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Converzation not opened.
You need to start the server V1 before running this ane.

In the preceding diagram, LabVIEW opens a conversation. It then uses
the DDE Advise Start VI to request notification of changes in the value
of a data item. Every time through the loop, LabVIEW calls the DDE
Advise Check VI, which waits for a data item to change its value.
When the loop is finished, LabVIEW ends the advise loop by calling
the DDE Advise Stop VI, and closing the conversation.

Synchronization of Data

The client server examples in the preceding section work well for
monitoring data. However, in these examples there is no assurance that
the client receives all the data that the server sends. Even with the DDE
Advise loop, if the client does not check for a data change frequently
enough, the client can miss a data value that the server provided.

In some applications, missed data is not a problem. For example, if you
are monitoring a data acquisition system, missed data may not cause
problems when you are observing general trends. In other applications,
you may want to ensure that no data is missed.
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One major difference between TCP and DDE is that TCP queues data
so that you do not miss it and you get it in the correct order. DDE does
not provide this service.

In DDE, you can set up a separate item, which the client uses to
acknowledge that it has received the latest data. You then update the
acquired data item to contain a new point only when the client
acknowledges receipt of the previous data.

For example, you can modify the server example shown in the
Requesting Data versus Advising Data section of this chapter to set a
state item to a specific value after it has updated the acquired data item.
The server then monitors the state item until the client acknowledges
receipt of data. This modification is shown in the following block
diagram:

data awvailable

state itern nam

ITEM

15

Serwice name

ITEH SERUER]

A client for this server, as shown in the following diagram, monitors
the state item until it changes to data available. At that point, the client
reads the data from the acquired data item provided by the server, and
then updates the state item to data read value.
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This technique makes it possible to synchronize data transfer between
a server and a single client. However, it has some shortcomings. First,
you can have only one client. Multiple clients can conflict with one
another. For example, one client might receive the data and
acknowledge it before the other client notices that new data is
available.You can build more complicated DDE diagrams to deal with
this problem, but they quickly become awkward. For applications that
involve only a single client, this is not a problem.

Another problem with this technique of synchronizing communication
is that the speed of your acquisition becomes controlled by the rate at
which you transfer data. You can address this issue by breaking the
acquisition and the transmission into separate loops. The acquisition
can queue data which the transmission loop would send. This is similar
to the TCP Server example in which the server handles multiple
connections.
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If your application needs reliable synchronization of data transfer, you
may want to use TCP/IP instead, because it provides queueing,
acknowledgment of data transfer, and support for multiple connections
at the driver level.

Networked DDE

You can use DDE to communicate with applications on the same
computer or to communicate over the network with applications on
different computers. To use networked DDE, you must be running
Windows for Workgroups 3.1 or greater and Windows NT. The
standard version of Windows 3.1 does not support networked DDE.

Each computer under Windows for Workgroups has a network
computer name. You configure this name using the Network control
panel.

When you communicate over the network, the meaning of the service
and topic strings change. The service name changes to indicate that you
want to use networked DDE, and includes the name of the computer
you want to communicate with. The service name is of the following
form.

\\computer-name\ndde$

You can supply any arbitrary name for the topic. You then edit the
SYSTEM. INT file to associate this topic name with the actual service
and topic that will be used on the remote computer. This configuration
also includes parameters that configure the network connection.
Following is an example of what this section would look like.

[DDE Shares]

topicname = appname, realtopic, ,31,,0,,0,0,0

The topicname is the name that your client VI uses for the topic.
Appname is the name of the remote application. With networked
DDE, this must be the same as the service name. Realtopic is the
topic to use on the remote computer. The remaining parameters
configure the way DDE works. Use the parameters as listed in the
preceding example. The meaning of these parameters is not
documented by Microsoft.

For example, if you want two computers running LabVIEW to
communicate using networked DDE, the server needs to use LabVIEW
for the service name, and a name, such as 1abdata, for the topic.
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Assuming the server computer name is Lab, the client tries to open a
conversation using the \ \Lab\ndde$ for the service. For the topic,
the client can use a name of remotelab.

For this to work, you must edit the SYSTEM.INI file of the server
computer to have the following line in the [DDEShares] section:

remotelab=LabVIEW, labdata,,31,,0,,0,0,0

For Windows NT, launch DDEShare. exe, which is located in the
winnt/system 32 directory. Choose Shares»DDE Shares... and then
select Add a Share... to register the service name and topic name on
the server.For more information, see the Using netDDE section of
Chapter 4, DDE VIs.

OLE Automation (Windows Only)

OLE (Object Linking and Embedding) Automation is a protocol for
accessing the functions and methods of one Windows application and
making them available for use by another Windows application. OLE
Automation works with Windows 95 and Windows NT only, not
Windows 3.x.

If an application exposes objects and provides a method of operating
on those objects, it is called an OLE automation server. Applications
that use the methods exposed by another application are OLE
automation clients/controllers.

LabVIEW contains VIs that enable it to become an automation client.
Helper VIs are provided.

AppleEvents (Macintosh Only)

AppleEvents is a Macintosh specific protocol that allows applications
to communicate with each other. As with DDE, it is a protocol in which
applications use a message to request actions or return information
from other applications. An application can send a message to itself, an
application on the same computer, or an application running on a
computer elsewhere on the network.

You can use AppleEvents to send other commands to other
applications, such as open or print, or to send data requests, such as
spreadsheet information.
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LabVIEW contains VIs for sending some of commands common to
most applications. The VIs are easy to use, and do not require detailed
knowledge of how AppleEvents work.

These VIs use the low level AESend VI to send AppleEvents. Apple
has defined a large vocabulary for messages to help standardize
AppleEvent communication. You can combine words in this
vocabulary to build complex messages. You can use this VI to send
arbitrary AppleEvents to other applications. However, creating and
sending AppleEvents at this level is complicated and requires detailed
understanding of AppleEvents. See Inside Macintosh and the
AppleEvent Registry.

Client Server Model

You cannot use the AppleEvent VIs to create LabVIEW diagrams that
behave as servers. The VIs are used to send messages to other
applications. If you need diagram-based server capabilities, you must
use TCP or PPC.

LabVIEW itself acts as an AppleEvent server, in that it understands
and responds to a set of AppleEvents. Specifically, using AppleEvents,
you can instruct LabVIEW to open VIs, print them, run them, and close
them. You can ask LabVIEW whether a given VI is running. You can
also tell LabVIEW to quit.

Using these server capabilities, you can instruct other LabVIEW
applications to run VIs, and control LabVIEW remotely. You can also
command LabVIEW to send messages to itself, instructing the loading
of specific VIs. For example, in large applications where memory is
limited, you can replace subVI calls with calls to the AESend Open,
Run, Close VI to load and run VIs as necessary. Notice that when you
run a VI this way its front panel opens, just as if you had selected
File»Open....

AppleEvent Client Examples
Launching Other Applications

To send a message to an application, that application must be running.
You can use the AESend Finder Open VI to launch another application.
This VI sends a message to the Finder. The Finder is, in itself, an
application that understands a limited number of AppleEvents. The
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following simple example shows how you can use AppleEvents to
launch Teach Text with a specific text file:

IHD text files :I

If the application is on a remote computer, then you must specify the
location of that computer. You can use inputs to the AESend Finder
Open VI to specify the network zone and the server name of the
computer with which you want to communicate. If the network zone
and server name are not specified, as in the preceding application, they
default to those of the current computer.

Notice that if you try to send messages to another computer, you are
automatically prompted to log onto that computer. There is no method
for avoiding this prompt, because it is built-in to the operating system.
This can cause problems when you want your application to run on an
unattended computer system.

Sending Events to Other Applications

Once an application is running, you can send messages to that
application using other AppleEvents. Not all applications support
AppleEvents, and those that do may not support every published
AppleEvent. To find out which AppleEvents an application supports,
consult the documentation that comes with that application.

If the application understands AppleEvents, you call an AppleEvent VI
with the Target ID for the application. A Target ID is a cluster that
describes a target location on the network (zone, server, and supporting
application). You do not need to worry about the exact structure of this
cluster because LabVIEW provides VIs that you can use to generate a
Target ID.

There are two ways to create a Target ID. You can use the Get Target
ID VI to programmatically create a Target ID based upon the
application name and network location. Or, you can use the PPC
Browser VI, which displays a dialog box listing applications on the
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network that are aware of AppleEvents. You interactively select from
this list to create a Target ID.

You can also use the PPC Browser VI to find out if another application
uses AppleEvents. If you run the VI and select the computer that is
running the application, the dialog box will list the application if it is
AppleEvent aware.

In the following diagram, LabVIEW interactively selects an
AppleEvent aware application on the network and tells it to open a
document. In this case, LabVIEW is telling the application to open a
VL

fro Labv e simple ]

Dynamically Loading and Running a VI

The AESend Open, Run, Close VI sends messages asking LabVIEW to
run a VI. First, it sends the Open Document Message and LabVIEW
opens a VI. Then, the Open Run Close VI sends the LabVIEW Run VI
message and LabVIEW runs the specified VI. Next, Open Run Close
sends the VI Active? message, and LabVIEW returns the status of a
specified VI, until the VI is no longer running. Finally, the VI sends the
Close VI message.

Assuming the target LabVIEW is on another computer, you could use
the following diagram to load and run the VI. If you are sending it to
the current LabVIEW, you do not need the PPC Browser VI.

o Latv B simple ]

0

]
%r{:l,.
AClose U
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PPC (Macintosh Only)

Program to Program Communication (PPC) is a Macintosh protocol for
transferring blocks of data between applications. You can use it to
create VIs that act as clients or servers. Although supported by all
Macintoshes running System 7.x, it is not commonly used by most
Macintosh applications. Instead, most Macintosh applications use
AppleEvents, a high-level protocol for sending commands between
applications, to communicate.

Although PPC is not as commonly supported as AppleEvents, it does
provide some advantages. Because it is at a lower level, it provides
better performance than AppleEvents. Also, in LabVIEW you can
create VIs that use PPC to act as clients or servers. You cannot create
diagrams that act as AppleEvent servers.

PPC is similar in structure to TCP, in terms of both server and client
applications. The PPC method for specifying a remote application is
different from the TCP method. Other than that, the two protocols
provide similar performance and features. Both protocols handle
queueing and reliable transmission of data. You can use both protocols
with multiple open connections.

In deciding between TCP and PPC, the main point to consider is which
platforms you plan to run your VIs on, and with which platforms you
will communicate. If your application is Macintosh only, PPC is a good
choice, because it is built-in to the operating system. TCP is built-in to
Macintosh operating system version 7.5. To use TCP with an earlier
system you must buy a separate TCP/IP driver from Apple. If buying
the separate driver is not an issue, then you may want to use TCP,
because the TCP interface is simpler than PPC. PPC uses some fairly
complicated data structures to describe addresses.

If your application must communicate with other platforms or run on
other platforms, then you should use TCP/IP.

Ports, Target IDs, and Sessions
To communicate using PPC, both clients and servers must open ports
that they use for subsequent communication. The Open Port VI opens
the port using a cluster that contains, among other things, the name that
you want to use for the port.
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Ports are used to distinguish between different services that an
application provides. Each application can have multiple ports open
simultaneously.

Each port can support several simultaneous sessions or conversations.
To open a session, a client uses a Target ID indicating the location of
the server. PPC uses the same type of Target ID that the AppleEvent
VIs use. You can use the PPC Browser or the Get Target ID VIs to
generate the Target ID for the remote application.

A server waits for clients to attempt to open a session by using the PPC
Inform Session VI. The server can accept or reject the session by using
the PPC Accept Session VI.

A client can attempt to open a session with a server by using the PPC
Start Session VI.

After the session is started, you can use the PPC Read and PPC Write
VIs to transfer data. You can close a session using PPC End Session,
and you can close a port using the PPC Close Port VI.

PPC Client Example

Open
Conn

to Srur

Exec
Crad
on Srur

The following discussion explains how you can use PPC to fulfill each
component of the general Client model.

Use the PPC Open Connection and PPC Open Session VIs to open a
connection to a server. This requires that you specify the Target ID of
the server, which you can get by using either the PPC Browser VI or
the Get Target ID VI. The end result is a port refnum and a session
refnum, which are used to communicate with the server.

To execute a command on the server, use the PPC Write VI to send the
command to the server. Next, use the PPC Read VI to read the results
from the server. With the PPC Read VI, you must specify the number
of characters you want to read. As with TCP, this can be awkward,
because the length of the response can vary. The server can have a
similar problem, because the length of a command may vary.

Following are several methods for addressing the problem of varying
sized commands. These methods can also be used with TCP.

© National Instruments Corporation 1-27 LabVIEW Communications VI Reference Manual



Chapter 1 Communication Applications in LabVIEW

Close
Conn
to Srur

e Precede the command and the result with a fixed size parameter
that specifies the size of the command or result. In this case, read
the size parameter, and then read the number of characters
specified by the size. This option is efficient and flexible.

e Make each command and result a fixed size. When a command is
smaller than the size, you can pad it out to the fixed size.

e  Follow each command and result with a specific terminating
character. To read the data, you then need to read data in small
chunks until you get the terminating character.

Use the PPC Close Session and PPC Close Connection VIs to close the
connection to the server.

PPC Server Example

Initialize

Seruver

W ait
for a
Conn

W' ait
for a
Crind

Exec
Crind

The following discussion explains how you can use PPC to fulfill each
component of the general Server:

Use PPC Open Port in the initialization phase to open a communication
port.

Use the PPC Inform Session VI to wait for a connection. With PPC,
you can either automatically accept incoming connections, or you can
choose to accept or reject the session by using the PPC Accept Session
V1. This process of waiting for a session and then approving the session
allows you to screen connections.

When a connection is established, you can read from that session to
retrieve a command. As was discussed in the PPC Client Example
section, you must decide the format for commands. If commands are
preceded by a length field, then you need to first read the length field,
and then read that amount of data.

Execution of a command should be protocol independent, because it is
something done on the local computer. When finished, you pass the
results to the next stage, where they are transmitted to the client.
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Use the PPC Write VI to return the result. As discussed in the PPC
Client Example section, the data must be formatted in a form that the
client can accept.

Use the PPC Close Session VI to close the connection.

Finally, when the server is finished, Use the PPC Close Port VI to close
the port that you opened in the initialization phase.

PPC Server with Multiple Connections

PPC handles multiple sessions and multiple ports easily. The methods
for implementing each component of a server, as described in the
preceding section, also work for a server with multiple connections.
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This chapter discusses Internet Protocol (IP), Transmission Control
Protocol (TCP), and internet addresses, and describes the LabVIEW
TCP VIs. Refer to Chapter 1, Communication Applications in
LabVIEW, for an overview of TCP/IP and examples of TCP client/
server applications.

The following illustration shows the TCP VI palette, which you access
by selecting Functions» Communication»TCP:
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For examples of how to use the TCP VIs, see the examples in
examples\comm\tcpex.llb.

You can find helpful information about individual VIs online by using
the LabVIEW Help window (Help»Show Help). When you place the
cursor on a VI icon, the wiring diagram and parameter names for that
VI appear in the Help window. You can also find information for front
panel controls or indicators by placing the cursor over the control or
indicator with the Help window open. For more information on the
LabVIEW Help window, refer to the Gerting Help section in Chapter 2,
Creating Vs, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online
information available. To access this information, select Help»Online
Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online
description. You can also access this information by pressing the
button shown to the left, which is located at the bottom of LabVIEW’s
Help window. For information on creating your own online reference
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files, see the Creating Your Own Help Files section in Chapter 25,
Managing Your Applications, of the LabVIEW User Manual.

Internet Protocol (IP)

Internet Protocol (IP) performs the low-level service of packaging data
into components called datagrams. A datagram contains, among other
things, the data and a header indicating the source and destination
addresses. IP determines the correct path for the datagram to take
across the network or internet, and sends the data to the specified
destination.

The original host may not know the complete path that the data will
take. Using the header, any host on the network can route the data to
the destination, either directly or by forwarding it to another host.
Because some systems have different transfer capabilities, IP can
fragment datagrams into smaller segments as necessary; when the data
arrives at the destination, IP automatically reassembles the data into its
original form.

IP makes a best-effort attempt to deliver data, but cannot guarantee
delivery. Also, because IP routes each datagram separately, they may
arrive out of sequence. In fact, IP may deliver a single packet more than
once if it is duplicated in transmission. IP does not determine the order
of packets. Instead, higher-level protocols layered above IP order the
packets and ensure reliable delivery. For this reason, IP is rarely used
directly; instead, TCP and UDP, which are built on top of IP, are most
often used to transfer information.

Transmission Control Protocol (TCP)

The Transmission Control Protocol (TCP) ensures reliable
transmission across networks, delivering data in sequence without
errors, loss, or duplication. When you pass data to TCP, it attaches
additional information and gives the data to IP, which puts the data into
datagrams and transmits it. This process reverses at the receiving end,
with TCP checking the data for errors, ordering the data correctly, and
acknowledging successful transmissions. If the sending TCP does not
receive an acknowledgment, it retransmits the data segment.
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Using TCP

TCP is a connection-based protocol, which means that sites must
establish a connection before transferring data. TCP permits multiple
simultaneous connections.

You initiate a connection either by waiting for an incoming connection
or by actively seeking a connection with a specified address. In
establishing TCP connections, you have to specify both the address and
a port at that address. A port is represented by a number between 0 and
65535. With UNIX, port numbers less than 1024 are reserved for
privileged applications. Different ports at a given address identify
different services at that address, and make it easier to manage multiple
simultaneous connections.

You can actively establish a connection with a specific address and
port using the TCP Open Connection VI. Using this VI, you specify the
address and port with which you want to communicate. If the
connection is successful, the VI returns a connection ID that uniquely
identifies that connection. Use this connection ID to refer to the
connection in subsequent VI calls.

You can use two methods to wait for an incoming connection:

e With the first method, you use the TCP Listen VI to create a
listener and wait for an accepted TCP connection at a specified
port. If the connection is successful, the VI returns a connection ID
and the address and port of the remote TCP.

e With the second method, you use the TCP Create Listener VI to
create a listener, and then use the Wait on Listener VI to listen for
and accept new connections. Wait on Listener returns the same
listener ID that was passed to the VI, as well as the connection ID
for a connection. When you are finished waiting for new
connections, you can use TCP Close to close a listener. You can
not read from or write to a listener.

The advantage of using the second method is that you can cancel a
listen operation by calling TCP Close. This is useful in the case where
you want to listen for a connection without using a timeout, but you
want to cancel the listen when some other condition becomes true (for
example, when the user presses a button).

When a connection is established, you can read and write data to the
remote application using the TCP Read and TCP Write VIs.
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Finally, use the TCP Close Connection VI to close the connection to
the remote application. Note that if there is unread data and the
connection closes, that data may be lost. This behavior is dependent
upon your operating system. For example, the Sun operating system
implementation will keep unread data even after the remote application
closes the connection, while Windows NT will immediately delete any
unread data when a close connection is received. Connected parties
should use a higher level protocol to determine when to close the
connection. Once a connection is closed, you may not read or write
from it again.

TCP Errors

The TCP VIs report errors in clusters as the following illustration
shows. See Appendix B, Error Codes, for a list of the TCP error codes
and their descriptions.

error im [no error) error out

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster is no error. The error in cluster contains the
following parameters:

status is TRUE if an error occurs. If status is TRUE, this VI does not

perform any operations, and error out contains the same information as
error in.

code is the error code. A value of 0 means no error.

source either gives the name of the TCP VI where the error occurs
followed by the error message, or the name of the last TCP VI to execute
followed by the no error message if no error occurs.
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error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

If a TCP VI receives an error cluster with a TRUE status flag, the VI passes the error

cluster out without changing it or attempting any TCP commands. If you do not wire
error in, it defaults to no error.

TCP VI Descriptions

IP To String

Converts an IP network address to a string.

net address narme

net address contains the network address.

dot notation determines whether name is in dot notation format.

name is the string equivalent of net address.

String To IP

Converts a string to an IP network address.

name {ZTE_IF] net address

name contains the string you want to convert. If you do not specify a string as an
input, the output is the current machine’s IP address.
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net address is the IP network address equivalent to name.

TCP Close Connection
Closes the connection associated with connection ID.

connection |0 connection D out

atujr't |:F:| eemnenen] ==

TGF
i

errar in |:I'Il:l E'I"r'l:lr'j e errar out

connection ID is a network connection refnum that identifies the connection that you
want to close.

abort determines whether LabVIEW closes the connection normally (the default
value) or aborts the connection. Currently, this parameter is ignored.

| B O

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of this chapter
for further description of the error in and error out clusters.

connection ID out has the same value as connection ID.

H

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

R

TCP Create Listener

Creates a listener for a TCP connection.

[ Torf— listener ID
port —-‘1_’;]’.

-

errar in [nn error) oo C ™ leooemgrror out

port is the port that the VI uses to listen for a connection.
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error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of this chapter
for further description of the error in and error out clusters.

listener ID is a network connection refnum that uniquely identifies the Listener.

error out contains error information. If error in indicates an error, then error out

= contains the same error information. Otherwise it describes the error status that this
VI produces.
TCP Listen
Creates a listener and waits for an accepted TCP connection at the specified port.
TCF connection D
port ‘“‘l_? wnemote address
timeout ms Cwait forever 1 -1) — " L— remote port
error in (no error) el R e ot

When a listen on a given port begins, you may not use another TCP Listen VI to listen
on the same port. For example, suppose a VI has two TCP Listen VIs on its block
diagram. If you start a listen on port 2222 with the first TCP Listen VI, any attempts to
listen on port 2222 with the second TCP Listen VI fail.

port is the port that the VI uses to listen for a connection.
timeout is in milliseconds. If the connection is not established in the specified time,

the VI completes and returns an error. The default value for timeout is -1, which
means wait indefinitely.

H[H

error in describes error conditions that occur prior to the execution of this VI. The
default input of this clusterisno error. See the TCP Errors section of this chapter
for further description of the error in and error out clusters.

connection ID is a network connection refnum that uniquely identifies the TCP
connection. You use this connection ID value to refer to this connection in
subsequent VI calls.

i
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remote address is the address of the remote machine associated with the TCP
connection. This address is in IP dot notation format. See the Internet Protocol (IP)
section of this chapter for a description of IP dot notation.

remote port is the port the remote system uses for the TCP connection.
error out contains error information. If error in indicates an error, then error out

contains the same error information. Otherwise it describes the error status that this
VI produces.

TCP Open Connection

Attempts to open a TCP connection with the specified address and port.

addres=s TCF connection D
remote port - !

tireout s (E0000) f error out
errar in [no error) Jm
Tocal part

address is the address with which you want to establish a TCP connection. This
address can be in IP dot notation or it can be a hostname. See the Internet Addresses
section for a description of valid specifications for address.

{Eil

remote port is the port of the specified address with which you want to establish a
TCP connection.

timeout is in milliseconds. If the connection is not established in the specified time,
the VI completes and returns an error. The default value for timeout is 60,000 ms (1
minute). A timeout value of -1 means wait indefinitely.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of this chapter
for further description of the error in and error out clusters.

local port is the port where you specify the local TCP connection port. Some servers
only allow connections to clients that use port numbers within a specified range that
is dependent on the server. If the value is 0, TCP will choose an unused port.
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connection ID is a network connection refnum that uniquely identifies the TCP
connection. You use this connection ID value to refer to this connection in
subsequent VI calls.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

TCP Read

Receives up to bytes to read bytes from the specified TCP connection, returning the
results in data out.

connection 10 o= TCF connection 10 out
bytes to read — e data out
timeout mz (250000 — | I —
error in (no error) el

connection ID is a refnum identifying the TCP connection.

bytes to read is the number of bytes to read from the specified connection.
timeout is in milliseconds. If the operation does not complete in the specified time,
the VI completes and returns an error. The default value is 25,000. A timeout value
of -1 means wait indefinitely.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of this chapter
for further description of the error in and error out clusters.

connection ID out has the same value as connection ID.

data out is a string that contains the data read from the TCP connection.

error out contains error information. If error in indicates an error, then error out

contains the same error information. Otherwise it describes the error status that this
VI produces.
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TCP Wait on Listener

Waits for an accepted TCP connection at the specified port.

listener I in —w liztener I out
A T—
timeaut ms Cwait forever :-1) W ? I_r'em-:-ie- add:egg
eFror in (no error]) oF Femate par
t“Lﬂﬂe-r'r'l:-r' out

connection [0

listener ID in is a network connection refnum identifying the Listener.

timeout is in milliseconds. If the connection is not established in the specified time,
the VI completes and returns an error. The default value is 25,000. A timeout value
of -1 means wait indefinitely.

il

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster is no error. See the TCP Errors section of this chapter
for further description of the error in and error out clusters.

listener ID out has the same value as listener ID in.

remote address is the address of the remote machine associated with the TCP
connection. This address is in IP dot notation format. See the Internet Addresses section
for a description of IP dot notation.

remote port is the port the remote system uses for the TCP connection.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this VI
produces.

connection ID is a network connection refnum that uniquely identifies the TCP
connection. You use this connection ID value to refer to this connection in subsequent
VI calls.

i BE EH
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TCP Write

Writes the string data in to the specified TCP connection.

connection |0 ———& TeF—— connection 1D out
data in et [ — bytes written

timeout ms (250000 — ] I
error in [no errar) i error out

connection ID is a refnum identifying the TCP connection.
data in is a string that contains the data to write to the TCP connection.
timeout is in milliseconds. If the operation does not complete in the specified time,

the VI completes and returns an error. The default value is 25,000. A timeout value
of -1 means wait indefinitely.

A H

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of this chapter
for further description of the error in and error out clusters.

connection ID out has the same value as connection ID.
bytes written is the number of bytes the VI writes to the specified connection.
error out contains error information. If error in indicates an error, then error out

contains the same error information. Otherwise it describes the error status that this
VI produces.

Hl [
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This chapter describes a set of VIs that you can use with User Datagram
Protocol (UDP), a protocol in the TCP/IP suite for communicating
across a single network or an interconnected set of networks.

The following illustration shows the UDP VI palette, which you access
by selecting Functions» Communication»UDP:

— LDOF ﬁ_II..IDF‘ l_v-é__l_.ll:lF‘ iILIDF‘
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You can find helpful information about individual VIs online by using
the LabVIEW Help window (Help»Show Help). When you place the
cursor on a VI icon, the wiring diagram and parameter names for that
VI appear in the Help window. You can also find information for front
panel controls or indicators by placing the cursor over the control or
indicator with the Help window open. For more information on the
LabVIEW Help window, refer to the Getting Help section in Chapter 2,
Creating VIs, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online
information available. To access this information, select Help»Online
Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online
description. You can also access this information by pressing the
button shown to the left, which is located at the bottom of LabVIEW’s
Help window. For information on creating your own online reference
files, see the Creating Your Own Help Files section in Chapter 25,
Managing Your Applications, of the LabVIEW User Manual.

User Datagram Protocol (UDP)

The User Datagram Protocol (UDP) transmits data across networks.
UDP can communicate to specific processes on a computer. When a

© National Instruments Corporation 3-1 LabVIEW Communications VI Reference Manual



Chapter 3 UDP VlIs

Using UDP

process opens a network connection to a particular port it only receives
datagrams that are addressed to that port on that computer. When a
process sends a datagram, it must specify the computer and port as the
destination.

There are several reasons why UDP is rarely used directly. UDP does
not guarantee data delivery. Each datagram is routed separately, so
datagrams may arrive out of order, be delivered more than once or not
delivered at all.

Typically, UDP is used in applications where reliability is not critical.
For example, an application might transmit informative data to a
destination frequently enough that a few lost segments of data are not
problematic.

UDP is not a connection-based protocol like TCP. This means that a
connection does not need to be established with a destination before
sending or receiving data. Instead, the destination for the data is
specified when each datagram is sent. The system does not report
transmission errors.

You can use the UDP Open VI to create a connection. A port must be
associated with a connection when it is created so that incoming data
can be sent to the appropriate application. The number of
simultaneously open UDP connections depends on the system. UDP
Open returns a Network Connection refnum, an opaque token used in
all subsequent operations pertaining to that connection.

You can use the UDP Write VI to send data to a destination and the
UDP Read VI to read it. Each write requires a destination address and
port. Each read contains the source address and port. Packet boundaries
are preserved. That is, a read never contains data sent in two separate
write operations.

In theory, you should be able to send data packets of any size. If
necessary, a packet is disassembled into smaller pieces and sent on its
way. At their destination, the pieces are reassembled and the packet is
presented to the requesting process. In practice, systems only allocate
a certain amount of memory to reassemble packets. A packet that
cannot be reassembled is thrown away. The largest size packet that can
be sent without dissassembly depends on the network hardware.

LabVIEW Communications VI Reference Manual 3-2 © National Instruments Corporation



Chapter 3  UDP Vis

When LabVIEW finishes all communications, calling the UDP Close
VI frees system resources.

UDP VI Descriptions

UDP Close

UDP Open

Attempts to open a UDP connection on the given port. Connection ID is an opaque
token used in all subsequent operations relating to the connection.

Closes the UDP connection specified by connection ID.

connection I —— UDF——— connection |0 out

s g o out

errar in [no eryor]) s

connection ID is a network connection refnum that identifies the connection that you
want to close.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster is no error. See the TCP Errors section of Chapter 1,
TCP VIs, for further description of the error in and error out clusters.

connection ID out has the same value as connection ID. If the connection is not
aborted, the connection is still valid, and the remote machine can continue to send
data.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

port EDP connection 10
1l
ertor in [no error) oo (== errar out
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UDP Vis

port is the local port with which you want to establish a UDP connection.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of Chapter 1,
TCP VIs, for further description of the error in and error out clusters.

connection ID is a network connection refnum that uniquely identifies the UDP
connection. You use this connection ID value to refer to this connection in
subsequent VI calls.

H

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

UDP Read

Returns a datagram in the string data out that has been received on the UDP connection
specified by connection ID.

connection D e HOF——— connection Dot
ras si%e I:54Elg — ‘%‘E tedata out
timeout mzs (23000) — ]
error in [no error) sl errar aut
port
address

connection ID is a network connection refnum that uniquely identifies the UDP
connection. You use this connection ID value to refer to this connection in
subsequent VI calls.

max size (548) is the maximum number of bytes to read.
timeout is in milliseconds. If the operation does not complete in the specified time,
the VI completes and returns an error. The default value is 25,000. A timeout value
of -1 means wait indefinitely.
error in describes error conditions that occur prior to the execution of this VI. The

default input of this cluster isno error. See the TCP Errors section of Chapter 1,
TCP VlIs, for further description of the error in and error out clusters.
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connection ID out has the same value as connection ID.

data out is a string that contains the data read from the UDP connection.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

port is the port of the UDP connection that sent the datagram.

address refers to the computer where a datagram originates.

Address and port indicate the source of the datagram. If no data is received in the
specified timeout period, a timeout error is reported in error out. Due to limitations
of the MacTCP driver, the Macintosh has a time out resolution of 1 second and a
minimum timeout of 2 seconds Max size is the maximum size to expect for the
incoming datagram. If the incoming datagram is larger than max size, the datagram
is truncated.

UDP Write
Writes the string data in to the remote UDP connection specified by address and port.
pott
address
connection I ———&2 UOFF——— connection D out
data in -f""""""
ertor in [no errar) eoooooood o oo out

port is the port of the specified address where you want to send a datagram.
address refers to the computer where you want to send a packet.

connection ID is a refnum identifying the UDP connection.

data in is a string that contains the data to write to the UDP connection.

error in describes error conditions that occur prior to the execution of this VI. The

default input of this cluster isno error. See the TCP Errors section of Chapter 1,
TCP VIs, for further description of the error in and error out clusters.
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connection ID out has the same value as connection ID.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

In an Ethernet environment, restrict data to 8192 bytes. In a LocalTalk environment,
restrict data to 1458 bytes because of gateway performance considerations.
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This chapter describes the LabVIEW VIs for Dynamic Data Exchange
(DDE) for Windows 3.1, Windows 95, and Windows NT. These VIs
execute DDE functions for sharing data with other applications that
accept DDE connections.

The following illustration shows the DDE VI palette, which you access
by selecting Functions»Communication»DDE:

5 0E| | [S] DOE = é
+—
I—F‘ l—i‘ OOE
OPEH| | CLOSE ZERIER
5 0E| | [S] DOE DDE

e

REGST POKE EXEL
ol DDE| | 12 DDE DDE

e [

S5THART]| | CHECK S5TOF

For examples of how to use the DDE VIs, see the examples in
examples\comm\DDEexamp.1llb.

You can find helpful information about individual VIs online by using
the LabVIEW Help window (Help»Show Help). When you place the
cursor on a VIicon, the wiring diagram and parameter names for that
VI appear in the Help window. You can also find information for front
panel controls or indicators by placing the cursor over the control or
indicator with the Help window open. For more information on the
LabVIEW Help window, refer to the Gerting Help section in Chapter 2,
Creating Vls, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online
? information available. To access this information, select Help»Online
Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online
description. You can also access this information by pressing the
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Dynamic Data

button shown to the left, which is located at the bottom of LabVIEW’s
Help window. For information on creating your own online reference
files, see the Creating Your Own Help Files section in Chapter 25, of
the LabVIEW User Manual.

Exchange

Dynamic Data Exchange is a client-controlled message passing
protocol. One application, the client, passes messages to another
application, the server.

Both applications must be running, and both must give Windows their
callback function address before DDE communication can begin. The
callback function accepts any DDE messages that Windows sends to
the application.

The client initiates a conversation with the server by sending a DDE
connect message. After establishing the conversation, the client can
send commands or data to the server, or request data from the server.

A client can request data from a server by a request or an advise. A
request is a single transfer of data. An advise establishes an active link
between the two applications. The server then informs the client every
time the advise value changes. When the client no longer needs the
changed values, it sends an advise stop message to the server.

When all the DDE communication for the conversation is complete, the
client sends a close conversation message to the server.

Using DDE as a Client

The Dynamic Data Exchange VIs give LabVIEW full DDE client
capability.

To use DDE, you must first establish a conversation using the DDE
Open Conversation VI. The VI must specify the service and the fopic.
The service usually corresponds to the name of the server application
and the topic to the active file. DDE messages then carry data to or
from specific locations in the active file. For more information on how
a specific application handles topic names and data item locations,
consult the documentation for that application.
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When you have established a conversation, you can send data using the
DDE Poke VI, send commands using the DDE Execute VI, obtain data
with the DDE Request VI, or initiate an advise protocol with the DDE
Advise Start VL.

The DDE Request VI sends a DDE message to the server every time
you call it. The server must then check the data requested and return it
in another DDE message. If your VI checks the value frequently, an
advise protocol might be more efficient than a request.

The DDE Advise Start VI creates a local copy of the data value you are
interested in. When you call the DDE Advise Check VI, the VI returns
this value without sending any DDE messages. At the same time, the
server application sends DDE messages every time the value changes,
so that the local value is always current. If the value seldom changes
but is often needed, an advise can significantly reduce the required
number of DDE messages.

Caution: During a conversation, you must pass the conversation refnum to all other
v DDE VIs involved in that conversation. Windows uses these refnums to
identify the conversation. If you alter the conversation refnum, or do not
specify or wire the conversation refnum, the VI will fail. The same is true
for the advise refnum. If you alter advise refnum, or do not specify or wire
advise refnum for the DDE Advise Check VI or the DDE Advise Stop VI,
the VIs will fail and may cause a system failure.

The DDE protocol used by LabVIEW is ASCII based, and the
transmission is terminated when a null byte is reached. If the binary
data has a null byte (00) in it, the transmission will end.

To send a number to another application, you must convert that number
to a string. In the same way, you must convert numbers received
through a request or advise from the string format. Use the conversion
VIs from Functions»String. See Chapter 4, String Functions, of the
LabVIEW Function Reference Manual for further information on how
to use string conversion VlIs.

Stop all advises and close all conversations using DDE Advise Stop
and DDE Close Conversation after all DDE commands have executed.
This releases the system resources associated with these VIs.
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Using DDE as a Server

Using netDDE

The first step to becoming a DDE server is to use the DDE Srv Register
Service VIto tell Windows what your service name and topic are going
to be. At this point other applications can open DDE conversations
with your service.

You can call the DDE Srv Register Service VI multiple times with
different service names to establish multiple services or multiple times
with the same service name but different topic names to establish
multiple topics for one service.

After specifying your service and topic names, you can define items for
that service using the DDE Srv Register Item VI. After this call, other
applications can request or poke the item, as well as initiate advises on
that item. LabVIEW fully manages all these transactions.

To change the value of an item, call the DDE Srv Set Item VI. This VI
changes the value and informs all clients that have advises on them.

To monitor whether a client has changed an item with a poke, call the
DDE Srv Check Item VI. This VI either returns the current value
immediately or waits until a client changes the value. If a client pokes
the value before DDE Srv Check Item is called with wait for poke true,
DDE Srv Check Item returns immediately and reports that the value
was poked.

You call the DDE Srv Unregister Item VI and the DDE Srv Unregister
Service VI to close down your DDE server when you are finished.
LabVIEW automatically disconnects any client conversations
connected to your server when DDE Srv Unregister Service is called.

NetDDE is built into Windows for WorkGroups 3.11, Windows 95 and
Windows NT. It is also available for Windows 3.1 with an add-on
package from WonderWare. If you are using Windows 3.1 with the
WonderWare package, consult the WonderWare documentation on
how to use netDDE.
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If you are using Windows for WorkGroups, Windows 95, or Windows
NT, use the following instructions:

SERVER MACHINE

Windows for Workgroups

Add the following line to the [DDE Shares] section of the file
system.ini on the server (application receiving DDE commands):

lvdemo = service_name, topic_name, ,31,,0,,0,0,0

where:
lvdemo can be any name

service_name is typically the name of the application, such as
excel

topic_name is typically the specific file name, such as sheetl

enter other commas and numbers as shown

Windows 95

Note: NetDDE is not automatically started by Windows 95. You need to run the
program\WINDOWS\NETDDE.EXE. (This can be added to the startup
folder so that it is always started.)

To set up a netDDE server on Windows 95:
e  Run\WINDOWS\REGEDIT.EXE.

* In the tree display, open the folder My Computer\
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
NetDDE\DDE Shares.

* Create a new DDE Share by selecting Edit»New»Key and give it
the name 1vdemo.

e  With the 1vdemo key selected, add the required values to the
share as follows. (For future reference, these keys are just being
copied from the CHATS share but REDEGIT does not allow you
cut, copy, or paste keys or values.) Use Edit»>New to add new
values. When you create the key, there will a default value named
(Default) and a value of (value not set). Leave these
values alone and add the following:

¢ Close REGEDIT.
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Value Type Name Value
Binary Additional item count 00 00 00 00
String Application service_name
String Item service_name
String Password1 service_name
String Password?2 service_name
Binary Permissionsl 1£ 00 00 00
Binary Permissions2 00 00 00 00
String Topic topic_name

* Restart the machine. (NetDDE must be restarted for changes to
take affect.)

Windows NT

Launch DDEShare. exe, foundinthewinnt /system32 directory.
Select from the Shares»DDE Shares»Add a Share... to register the
service name and topic name on the server.

CLIENT MACHINE

On the client machine (application initiating DDE conversation) no
configuration changes are necessary.

Use the following inputs to DDE Open Conversation.wvi:
Service: \\machine_ name\ndde$
Topic: 1vdemo

where:
machine_name specifies the name of the server machine

1lvdemo matches the name specified in the [DDE Shares] section
on the server.
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Consider the examples Chart Client.vi and Chart
Server.vi found in examples\network\ddeexamp.1l1lb. To
use those VIs to pass information between two computers using
netDDE, you should do the following:

Server Machine:

1. Do not modify any front panel values.

2. Inthe system. ini file of the Server machine, add the following
line in the [DDEShares] section:
lvdemo = TestServer, Chart,,31,,0,,0,0,0

Client Machine:

On the front panel, set the controls to the following:
Service = \ \machine_name\ndde$

Topic = 1vdemo

Item = Random

DDE VI Descriptions

DDE Client Vis
This section discusses the DDE Client VlIs.

DDE Advise Check
Checks an advise value previously established by DDE Advise Start.

tirmeaut(-1) —

adrvise refnum —
*

[T [DE advize refnum
frrnnnnhn crrent data
wait far change ?(F ALSE) -~ CHECE boesy - changed ?

error in (no error) mrm ===.E====-1!-rn]nr out

Unused sefemnen

advise refnum is the unique number that identifies this DDE advise link.
error in describes error conditions that occur prior to the execution of this VI. The

default input of this cluster is no error. See the TCP Errors section of Chapter 1,
TCP VIs, for further description of the error in and error out clusters.
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timeout specifies how long to wait for the function to complete. The default value of
-1 specifies no timeout. If the specified amount of time expires before completion,
the VI returns an error.

unused was previously the old data input. The DDE VIs now can track changes to the
data internally so this input is no longer needed. It remains so that VIs that used it
will not break.

wait for change? specifies whether the VI should get the current value and return
immediately or wait until the value changes before returning.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

advise refnum is the unique number that identifies this DDE advise link. It passes
through this VI to assist in execution timing.

current data always returns the most recently received value for the advise item.

changed? specifies whether the old data is the same as current data.

i B

DDE Advise Start

Initiates an advise link.

conversation refnum advize refnum

error inlno error) s error aut

conversation refnum is the unique number that identifies this DDE conversation.

item is the location of the data from the server application that the VI communicates
to the client application.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster is no error. See the TCP Errors section of Chapter 1,
TCP VlIs, for further description of the error in and error out clusters.

] HE
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advise refnum is the unique number that identifies this DDE advise link.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

DDE Advise Stop
Cancels an advise link, previously established by DDE Advise Start.

advise refnum DE conversation refnum
-

Ty

error inino error]) eooeeees) STOP perewress a-por oot

advise refnum is the unique number that identifies this DDE advise link.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of Chapter 1,
TCP Vs, for further description of the error in and error out clusters.

conversation refnum is the unique number that identifies this DDE conversation.
Pass it through this VI to assist in execution timing.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

DDE Close Conversation

Closes a DDE conversation.

conversation refnum — DDE
mode(T close immediately) -

error in (no error) oo CLOSEprreersarrgr out

© National Instruments Corporation 4-9 LabVIEW Communications VI Reference Manual



Chapter4 DDE Vs

conversation refnum is the unique number that identifies this DDE conversation.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of Chapter 1,
TCP VIs, for further description of the error in and error out clusters.

HE

mode controls when the conversation closes. If mode is TRUE, the DDE
conversation is always closed. If mode is FALSE, the conversation closes only when
an error passes in. Thus, if you wire the error out of another DDE VI to the error in
of the Close Conversation VI with a FALSE mode, the conversation terminates only
if an error occurs in the first VI.

TF

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

DDE Execute

Tells the DDE server to execute command.

tireout [-11

conversation refnum
command ~3y

conversation refnunm

error in (I'Iﬂ errur:l L error out

conversation refnum is the unique number that identifies this DDE conversation.
command contains the command to be sent.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of Chapter 1,
TCP Vls, for further description of the error in and error out clusters.

timeout specifies how long to wait for the function to complete. The default value of
-1 specifies no timeout. If the specified amount of time expires before completion,
the VI returns an error.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.
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conversation refnum is the unique number that identifies this DDE conversation. It
passes through this VI to assist in execution timing.

DDE Open Conversation
Establishes a connection between LabVIEW and another application. You must call this
VI before you use any other DDE VIs (except Server VIs).

SErvice - DE conver=sation refnumm

topic ~tmomn= (S

p ‘—h

errar inlno error) seeeesoes)  OPE Moo oy or out

service is the name of the DDE server.
topic is the name of the DDE topic.
P p

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster is no error. See the TCP Errors section of Chapter 1,
TCP Vs, for further description of the error in and error out clusters.

conversation refnum is the unique number that identifies this DDE conversation.
Returns 0 if an error occurs.

--n-_ error out contains error information. If error in indicates an error, then error out
- o . . . . . . .
contains the same error information. Otherwise it describes the error status that this
VI produces.

DDE Poke

Tells the DDE server to put the value data at item.

tirneout (=10
conversation refnum | S TE convetzation refnum
data "
. FOLE error out
error in (no error)
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conversation refnum is the unique number that identifies this DDE conversation.
item is the location where the VI pokes the data.
data contains the data the VI sends.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of Chapter 1,
TCP VIs, for further description of the error in and error out clusters.

timeout specifies how long to wait for the function to complete. The default value of
-1 specifies no timeout. If the specified amount of time expires before completion,
the VI returns an error.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

conversation refnum is the unique number that identifies this DDE conversation. It
passes through this VI to assist in execution timing.

DDE Request

Initiates a DDE message exchange to obtain the current value of item.

conversation refnum

tireout (-11

conversation refnium

item wrmomen data

error in (I'Iﬂ errnr] i error out

conversation refnum is the unique number that identifies this DDE conversation.
item is the location of the requested data.
error in describes error conditions that occur prior to the execution of this VI. The

default input of this cluster is no error. See the TCP Errors section of Chapter 1,
TCP VlIs, for further description of the error in and error out clusters.

LabVIEW Communications VI Reference Manual 4-12 © National Instruments Corporation



Chapter4  DDE Vs

timeout specifies how long to wait for the function to complete. The default value of
-1 specifies no timeout. If the specified amount of time expires before completion,
the VI returns an error.

f

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

ﬂ

conversation refnum is the unique number that identifies this DDE conversation. It
passes through this VI to assist in execution timing.

data contains the data that the DDE Request returns.

DDE Server Vis

This section discusses the DDE Server VIs. To access these VIs, pop up on the DDE
Server icon located on the DDE palette:

= DDE Server

+ Dpee||t poe(|f DOE|f+ DDE ws. %
3 — [ E — S| D — |2

SERVER| | ITEM SET CHECK || ITEM ||SERVER

DDE Srv Check Item

Sets the value of a previously defined DDE Item.

tireout £-1)

item refoum — 4 peef——item refnum
wait for poke(F ALSEY — "_, 1
error in (no error) seoooe{ CHECE nlu;pnke-d?

error out

item refnum is the unique number that identifies this DDE item.
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error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of Chapter 1,
TCP VIs, for further description of the error in and error out clusters.

timeout specifies how long to wait for the function to complete. The default value of
-1 specifies no timeout. If the specified amount of time expires before completion,

the VI returns an error.

wait for poke specifies whether the VI should get the current value and return
immediately or wait until a client pokes the value before returning.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

item refnum is the unique number that identifies this DDE item.

value is the new value for the item.

poked? specifies whether the item has been poked by a DDE client since the last
DDE Srv Check Item.

DDE Srv Register ltem

A EHE

Establishes a DDE item for the service specified by service refnum.

service refnum —— ¢+ poe[— item refnum
item vﬂ"mL
value [=7) 17772
. ITEM oo arror out
error in (no error) —

service refnum is the unique number that identifies this DDE service.

item is the name of the DDE item

value is the initial value for the item.

error in describes error conditions that occur prior to the execution of this VI. The

default input of this cluster is no error. See the TCP Errors section of Chapter 1,
TCP VlIs, for further description of the error in and error out clusters.
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error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

item refnum is the unique number that identifies this DDE item. Returns O if an error
occurs.

DDE Srv Register Service

Establishes a DDE service to which clients can connect.

service + DbE service Fefnum
- "d'u'm
topic .
error in (no error) soccooxSERUER error out

service is the name of the DDE server.
topic is the name of the DDE topic.
error in describes error conditions that occur prior to the execution of this VI. The

default input of this cluster is no error. See the TCP Errors section of Chapter 1,
TCP VIs, for further description of the error in and error out clusters.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

service refnum is the unique number that identifies this DDE service. Returns 0 if
an error occurs.
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DDE Srv Set Item

HEE

E

Sets the value of a previously defined DDE Item.

item refnum + gnE—item refrurm
phopls
value [7) ~ \
error in (no error) oo SET oo arror out

item refnum is the unique number that identifies this DDE item.

value is the new value for the item.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster is no error. See the TCP Errors section of Chapter 1,
TCP VlIs, for further description of the error in and error out clusters.

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this

VI produces.

item refnum is the unique number that identifies this DDE item.

DDE Srv Unregister ltem

g

=mo

Removes the specified item from its service. DDE clients can no longer access the item
after this VI completes.

item refnum DDE service refnum
=1
error in {no error) ITEM error out

item refnum is the unique number that identifies this DDE item.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster isno error. See the TCP Errors section of Chapter 1,
TCP VlIs, for further description of the error in and error out clusters.
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error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.

service refnum is the unique number that identifies this DDE service.

DDE Srv Unregister Service

Removes the specified service. DDE clients can no longer connect to this service and all
current conversations will be closed.

service refnum — DDE
|__—1

error in (no error) {SERUER error out

service refnum is the unique number that identifies this DDE service.

error in describes error conditions that occur prior to the execution of this VI. The
default input of this cluster is no error. See the TCP Errors section of Chapter 1,
TCP VlIs, for further description of the error in and error out clusters.

[

error out contains error information. If error in indicates an error, then error out
contains the same error information. Otherwise it describes the error status that this
VI produces.
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This chapter discusses the LabVIEW VIs for OLE (Object Linking and
Embedding) Automation, a feature which allows LabVIEW to access
objects exposed by automation servers in the system.

The OLE Automation VI Library contains two levels of VIs. VIs that
are available on the Communication palette represent the higher level
of functionality. These VIs use lower level VIs which are hidden from
the user, providing for a higher level of encapsulation. Helper VIs are
provided.

Note: These VIs work under Windows NT and Windows 95 only.

The following illustration shows the OLE Automation VI palette,
which you access by selecting Functions» Communication»OLE:

T o] [P i
20
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[=] SLE [ :=] 9LE
IE SE
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@‘[ﬂ]m] ~:.ﬁ;

For examples of how to use the OLE Automation VIs, see the examples
in examples\comm\OLE-xxx.11b.

You can find helpful information about individual VIs online by using
the LabVIEW Help window (Help»Show Help). When you place the
cursor on a VI icon, the wiring diagram and parameter names for that
VI appear in the Help window. You can also find information for front
panel controls or indicators by placing the cursor over the control or
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indicator with the Help window open. For more information on the
LabVIEW Help window, refer to the Getting Help section in Chapter 2,
Creating Vls, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online
information available. To access this information, select Help»Online
Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online
description. You can also access this information by pressing the
button shown to the left, which is located at the bottom of LabVIEW’s
Help window. For information on creating your own online reference
files, see the Creating Your Own Help Files section in Chapter 25,
Managing Your Applications, of the LabVIEW User Manual.

OLE Automation Concepts

In the context of Object Linking and Embedding, objects are defined
as data abstractions exported by an application. You can manipulate
these objects by using another Windows application. Linking and
Embedding are two of the methods used to access OLE objects.

You can use OLE Automation to make the functions and methods of
one application available for use by other applications. You then access
these functions or methods, which are usually grouped into objects.

An application supports automation either as a server or a client.
Applications that expose objects and provide methods for operating on
those objects are called OLE automation servers. Applications that use
the methods exposed by another application are called OLE automation
clients/controllers. The OLE VIs enable LabVIEW to become an
automation client.

Using LabVIEW to Implement OLE Automation

An OLE object exposes both methods and properties. Methods have
the ability to modify a wide range of values, whereas properties can set
or get the value of a specific characteristic of the object. Some servers
provide a type library listing all exposed objects and the methods and
properties of each object.
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The typical steps in creating a client application using C are as follows:

*  Get the IDispatch interface of the Object whose methods you want
to access.

e Get the DispatchID of the method of that object.

¢ Invoke the method using the Invoke functions of the IDispatch
interface, packing all parameters into the parameter list.

In LabVIEW, do as follows:

e Use the Create Automation Refnum VI to get an Automation
refnum which uniquely defines the IDispatch interface.

*  Use the Execute Method VI to execute a method belonging to that
object. If there is just one parameter, it can be flattened. The type
descriptors and the flattened string are then passed in as input
parameters. If there are multiple outputs, they are bundled in a
cluster. The resultant cluster is then flattened and wired to the
correct input of the VI.

The implementation uses DLLs to perform the actual OLE calls.
Parameters are passed to these DLLs as flattened data.

OLE Automation VI Descriptions

Create Automation Refnum
Given the object name (registered class name) of an OLE object, returns an Automation
Refnum uniquely identifying the instantiation.

dutomation Refrum

Object Name

=] OLE
-
error in [no error) eeocooeofBBE T pooooooes aror out

Object Name. The class name of an OLE object.

error in describes error conditions prior to the execution of this VI. The default input
isno error.

Automation Refnum. A value which uniquely defines an instantiation of an OLE
class.
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error out contains error information. If error in indicates an error, then error out
contains that same information. Otherwise, it describes the error status produced by
this VI.

Execute Method

Executes a method.

Automation Refnum — =] JLE——— Autornation Refnumm
Input Type Descriptor

errar in (no error)

HMethod Name _I—'“E }=:E L Return Yalue Type Dezcriptor
ﬂ&eturn Malue Data String
errar aut

Input Diata String e

I16

Ly |
—_

I16

Ly |
| B }

Automation Refnum. A value which uniquely defines an instantiation of an OLE
class.

Method Name. Name of the method in that class to be invoked.

Input Type Descriptor. See Appendix A, Data Storage Formats, of the LabVIEW
User Manual.

Input Data String. The flattened string, passed as an input parameter. For more
information, see the Using LabVIEW to Implement OLE Automation section of this
chapter.

error in describes error conditions prior to the execution of this VI. The default input
isno error.

Automation Refnum. The Automation Refnum passed to a VI. The dup is provided
to simplify dataflow programming in a manner similar to the dup file refnums in file
I/0 functions.

Return Value Type Descriptor. See Appendix A, Data Storage Formats, of the
LabVIEW User Manual.

Return Value Data String. The flattened string, passed as an output parameter. For
more information, see the Using LabVIEW to Implement OLE Automation section of
this chapter.
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error out contains error information. If error in indicates an error, then error out
contains that same information. Otherwise, it describes the error status produced by
this VI.

Get Property

Gets the value of a property.

Automation Refnum =] — Autamation Eefnum
Property Name A b Frroperty Type Descriptor
error in [no ertor) eeccooo FHDF{PWPEHQ Cata String

error aut

Automation Refnum. Value uniquely defining an instantiation of an OLE class.
Property Name. Name of property in that class.

error in describes error conditions prior to the execution of this VI. The default input
isno error.

Automation Refnum. The Automation Refnum passed to a VI. The dup is provided
to simplify dataflow programming in a manner similar to the dup file refnums in file
I/0 functions.

Property Type Descriptor. See Appendix A, Data Storage Formats, of the
LabVIEW User Manual.

Property Data String. The flattened string, passed as an output parameter. For more
information, see the Using LabVIEW to Implement OLE Automation section of this
chapter.

—
=
ﬁ H
&

error out contains error information. If error in indicates an error, then error out
contains that same information. Otherwise, it describes the error status produced by
this VI.
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List Methods or Properties

Lists all the methods or properties of an object.

Method /Property Flag mﬁl:l:l FUMNCS

Object Libary File
Ok ject Marne R LIST

Methods /Properties

oo g o ot

errar in [no ervor)

m
™
il

Object Library File. Full path name of the object library file (* .olb, *.tlb).
Object Name. String containing the name of the object.
Method/Property Flag. If set, lists all methods. Otherwise, lists all properties.

error in describes error conditions prior to the execution of this VI. The default input
isno error.

Methods/Properties. An array of strings containing all the methods and/or
properties in that object.

error out contains error information. If error in indicates an error, then error out
contains that same information. Otherwise, it describes the error status produced by
this VI.

List Objects in Type Library

Lists all the objects in a type library.

Ob ject Libary File

o
L

: pocasass: Ob jects

. L ISTALL
errar in |:|-||:| E'l"l"l:ll":l mmﬂsm errar aut

Object Library File. Full path name of the object library file (* .olb, *.tlb).
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error in describes error conditions prior to the execution of this VI. The default input
isno error.

Objects. An array of strings containing all objects defined in the object library file.
error out contains error information. If error in indicates an error, then error out

contains that same information. Otherwise, it describes the error status produced by
this VI.

"
e
Ll

Release Refnum
Releases the refnum passed in as input.

Automation Refnum ——-A; =]
) B ========-e-r'r'n:ur' out
BFrar in [no error) seeeooeep RS

Automation Refnum. Value uniquely defining an instantiation of an OLE class.

error in describes error conditions prior to the execution of this VI. The default input
isno error.

error out contains error information. If error in indicates an error, then error out
contains that same information. Otherwise, it describes the error status produced by
this VL.
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Set Property

Sets the value of a property.

Automation Refnum

P OLE— dutormation Befnum
Property Name

T
Input Type Descriptor fEEFHquerrnr‘ out
Input Cata String E

ertor in Lno error)

[116]

Automation Refnum. Value uniquely defining an instantiation of an OLE class.
Property Name. Name of the property in that class.

Input Type Descriptor. See Appendix A, Data Storage Formats, of the LabVIEW
User Manual.

Input Data String.The flattened string, passed as an input parameter. For more
information, see the Using LabVIEW to Implement OLE Automation section of this
chapter.

error in describes error conditions prior to the execution of this VI. The default input
isno error.

Automation Refnum. The Automation Refnum passed to a VI. The dup is provided
to simplify dataflow programming in a manner similar to the dup file refnums in file
I/0 functions.

error out contains error information. If error in indicates an error, then error out
contains that same information. Otherwise, it describes the error status produced by
this VI.
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This chapter discusses the LabVIEW VIs for interapplication
communication (IAC), a feature of Apple Macintosh system software
version 7 by which Macintosh applications can communicate with each
other. You can use LabVIEW with two forms of IAC, AppleEvents and
program to program communication (PPC).

AppleEvents are a high-level method of communication in which
applications use messages to request other applications to perform
actions or return information. An application can send these messages
to itself, other applications on the same machine, or other applications
located anywhere on a network. Apple has defined a large vocabulary
for messages to help standardize this form of interapplication
communication. You can combine words in this vocabulary to form
very complex messages. This vocabulary is described in detail in the
AppleEvent Registry, a document available from Apple. Most
applications written for System 7, including LabVIEW, respond to
some subset of AppleEvents.

PPC is alow-level form of IAC by which applications send and receive
blocks of data. PPC provides higher performance than AppleEvents,
because the overhead required to transmit information is lower.
However, because PPC does not define what kinds of information you
can transfer, many applications do not support it. PPC is the best way
to send large amounts of information between applications that support
PPC. See Chapter 7, Program to Program Communication VlIs, for
more information about PPC.
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The following illustration shows the AppleEvents VI palette, which
you access by selecting Functions» Communication»AppleEvent :

e]ls

L= ESEN D EENE RSN RSN S
[Z)0pen|| @pen || Open || Do Quit
o I | b

| o

=T iEI

Note: For applications to communicate with IAC, the computer must use system
software version 7.0 or greater with Program Linking enabled.

For examples of how to use the AppleEvent VIs, see the examples
located in examples\comm\AE Examples.llb.

You can find helpful information about individual VIs online by using
the LabVIEW Help window (Help»Show Help). When you place the
cursor on a VI icon, the wiring diagram and parameter names for that
VI appear in the Help window. You can also find information for front
panel controls or indicators by placing the cursor over the control or
indicator with the Help window open. For more information on the
LabVIEW Help window, refer to the Getting Help section in Chapter 2,
Creating Vs, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online
information available. To access this information, select Help»Online
Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online
description. You can also access this information by pressing the
button shown to the left, which is located at the bottom of LabVIEW’s
Help window. For information on creating your own online reference
files, see the Creating Your Own Help Files section in Chapter 25,
Managing Your Applications, of the LabVIEW User Manual.
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LabVIEW can send and respond to AppleEvents. You can use
AppleEvent VIs to send AppleEvents. LabVIEW responds to two types
of AppleEvents: LabVIEW-defined events and a subset of standard
AppleEvents. See the Sending AppleEvents section of this chapter for
more information.

Some of the ways you can use AppleEvents in LabVIEW applications
are listed on the following page:

*  You can command LabVIEW to tell another application (even an
application on another computer connected by a network) to
perform an action. For example, LabVIEW can tell a spreadsheet
program to create a graph. See the Sending AppleEvents section in
this chapter for details.

*  Youcanuse a program such as HyperCard as a front end to instruct
LabVIEW to run specific VIs.

*  You can communicate with and control LabVIEW applications on
other machines connected by a network by sending them
instructions to perform specific operations. See the Sending
AppleEvents section in this chapter for details.

*  You can command LabVIEW to send messages to itself,
instructing itself to load, run, and unload specific VIs. For
example, in large applications where memory is tight, you can
replace subVI calls with a utility VI (the AESend Open, Run,
Close VI) and dynamically load, run, and unload the VIs. See the
Sending AppleEvents section in this chapter for details.

The following sections describe in detail how LabVIEW sends and
receives AppleEvents.

Sending AppleEvents

The Communication subpalette of the Functions palette contains VIs
for sending AppleEvents. With these VIs, you can select a target
application for an AppleEvent, create AppleEvents, and send the
AppleEvents to the target application.

The AppleEvent VIs palette of the Communication subpalette
contains VIs that send specific AppleEvent messages. These VIs let
you send several standard AppleEvents (Open Document, Print
Document, and Close Application) and all the LabVIEW custom
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AppleEvents. These high-level VIs require little understanding of
AppleEvent programming details. Their diagrams also serve as good
examples of how to create and send AppleEvents.

You can use the low-level AESend VI if you want to send an
AppleEvent for which LabVIEW provides no VI. The AppleEvent VIs
palette of the Communication subpalette also contains VIs that can
help you create an AppleEvent. However, creating and sending an
AppleEvent at this level requires detailed understanding of
AppleEvents as described in Inside Macintosh, Volume VI and the
AppleEvent Registry.

General AppleEvent VI Behavior

When sending an AppleEvent, you must specify the target application
for the event. To receive the AppleEvent, the target application must
be open. You can use the AESend Finder Open VI to open an
application.

The User Identity Dialog Box

Before you send an AppleEvent to another computer, you must use the
Users & Groups control panel utility on the destination computer to set
up a user name and password for yourself. The first time you send an
AppleEvent to an application or Finder on the destination computer, a
dialog box prompts you to enter your name and password. The system
compares this information to the configuration of the Users & Groups
control panel utility on the destination computer.
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&

Connect to the file server "Macintosh HD" as:

1 Guest
i@ Registered User

Name: || |

Fassword: |:| (Two-way Scrambled)
[ Cancel ] [Set Passu.lurd]

w7.0

The current design of the AppleEvent Manager does not include a
programmatic method for bypassing this dialog box, so you should take
this into account when designing VIs that use IAC. For example, you
cannot command an unattended remote computer to send an
AppleEvent to a third computer; someone must enter user information
into the User Identity Dialog Box that appears on the remote computer.
The PPC VlIs allow for unauthenticated sessions if guest access is
enabled on the computer with which you wish to communicate, so you
may find the PPC VIs more useful for certain kinds of LabVIEW-to-
LabVIEW communication.

Target ID

Most VIs that send AppleEvents need a description of the target
application that will receive the AppleEvent. The target ID is a
complex cluster of information, defined by Apple Computer Inc.,
describing the target application and its location. The following VIs
generate the target ID, so you do not need to create this cluster on the
diagram.

* PPC Browser creates the target ID by displaying a dialog box by
which you interactively select AppleEvent-aware applications on
the network.
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below.

e Get Target ID creates the target ID programmatically based on the
application's name and network location.

These VIs are discussed in more detail in the Targeting Vls section of
this chapter.

You need to look at the target ID cluster only if you want to pass target
information from one VI to another. To create a target ID cluster for
the front panel of a VI that passes target information to another VI or
to an AppleEvent, you can copy the target ID cluster from the front
panel of one of the AppleEvent VlIs.

Send Options

Many of the VIs that send an AppleEvent have a send options input,
which specifies whether the target application can interact with the
user and the length of the AppleEvent timeout.

=zend options

@ @Eerver rnay corme 1o T’-:-r'egr'l:-un-:l|
@ @l[ﬁlun't try to r'ec-:-nne-ct|

tranzaction IDlElﬂ |
El.ﬁ.ﬂnw Interaction " [timeout tickﬂHEDD 1

send options is a cluster containing the following parameters in the order listed

want reply specifies whether you want to receive a reply. The default is
TRUE.

TRUE Asynchronously wait for a response from the application
until the VI receives a response or a timeout occurs.
FALSE Send the AppleEvent and do not wait for a reply.

high priority determines whether the AppleEvent is added to the
beginning or end of the target application's event queue. The default is
FALSE.
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TRUE Put the event at the front of the target application event
queue.

FALSE Add the event to the end of the target application event
queue.

interaction mode determines the level of user interaction of the target
application. The default is 1.

(Never Interact) Do not interact with the user.

1: (Allow Interaction) Can interact with the user if the target
application needs information.
2: (Always Interact) Can interact with the user even if the

target application does not need information.

server may come to foreground specifies whether the application can
come to the foreground if it needs user interaction. The default is TRUE.

TRUE Can automatically switch to the foreground.
FALSE Notifies the user by flashing the application icon in the
menu bar.

don't try to reconnect determines whether the system should try to
reconnect if it is disconnected. The default is FALSE.

TRUE Do not attempt to reconnect if disconnected.
FALSE Attempt to reconnect if disconnected.

transaction ID is a number associated with a sequence of AppleEvents.
If you will be sending multiple AppleEvents related to a single
transaction, use the same number throughout the transaction. The
default is 0.

timeout ticks determines how long in ticks (1/60 of a second) LabVIEW
waits for a reply before timing out if you entered TRUE for want reply.
Use a value of 0 if you do not want a timeout. The default is 600 ticks,
or 10 seconds.
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Targeting VI Descriptions

Get Target ID

Returns a target ID for a specified application based on its name and location. You can
either specify the application's name and location or the VI searches the entire network
for the application.

App Sport name pocceeees fiFct target D
Search entire netwark -7 mﬂml_ total targets

Zone o] ] Giet 1D —| all targets
Server '-""jm Brror

App/port name is the name of the application for which you want the target ID. This
parameter must exactly match the name of the application.

Search entire network determines whether the VI searches the entire network for
the specified application. See the table in this section for a further discussion of
search options.

TF

Zone specifies the target computer’s zone that the VI searches. See the table in this
section for a further discussion of search options.

Server specifies the server that the VI searches. See the table in this section for a
further discussion of search options.

first target ID contains the target ID of the first application found whose name
matches App/port name.

total targets is the total number of applications that the VI finds whose names match
App/port name.

o all targets contains an array of the target IDs of all matching applications.

—i
o
_

error is non-zero only if something goes wrong during the search. Finding zero
targets is not necessarily an error if there are no applications with the specified name
running and available on the network. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.
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The following table summarizes the operation of Search entire network, Zone, and

Server:
To search the following Use the following parameters:
locations:
The current computer Zone and Server must be unwired. Search entire network must

be FALSE.

A specific computer on | Zone and Server must specify the target computer’s zone and
the network server. (If you do not wire Zone, the VI searches the current
zone.) Search entire network must be FALSE.

A specific zone Zone must specify the zone to be searched. Server must be
unwired. Search entire network must be FALSE.

The entire network Search entire network must be TRUE. The VIignores Zone and
Server.

PPC Browser

Invokes the PPC Browser dialog box for selecting an application on a network or on the
same computer

Tocation MEF type
prornpt

dpplication Tist label
default specified - g
default target D

selected target ID
errar

location NBP type determines which computers on the network LabVIEW displays
in the dialog box. If this string is empty (default), only computers with applications
using the PPC Toolbox appear in the dialog box.

prompt is the message that LabVIEW displays in the dialog box. If this string is
empty (default), Choose a program to link to: appears in the dialog box.

© National Instruments Corporation 6-9 LabVIEW Communications VI Reference Manual



Chapter 6  AppleEvent Vis

TF

HEHEE

You can use this standard Macintosh dialog box to select a zone from the network,
an object in that zone (in System 7, this is typically the name of a person's computer),
and an application. The VI then returns the target ID cluster.

Prompt
Macintoshes Application List Label
bowlorama {#| || File Sharing Extension [0 |
Finder
Lab' [EWw
3
AppleTalk Zones
1st & 2nd Floors |
3rd Floor
dth Floor
o]
FPhasze 11
o

Application list label is the title that appears for the list of PPC ports. If this string
is empty (default), the title Programs appears.

default specified determines whether LabVIEW uses the default target ID
parameter.

default target ID identifies and highlights the target that PPC Browser attempts to
find.

target ID is a cluster that the VI returns after you make selections from the dialog
box. See the Target ID section of this chapter for a further description of this cluster.

error if negative, indicates a Macintosh error. If positive, error indicates an error

internal to the CIN that generated it. error 128 signifies that the user cancelled

the dialog box. See the AppleEvent Error Codes section of Appendix B, Error Codes,
for more information.
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AppleEvent VI Descriptions

AESend Do Script

Sends the Do Script AppleEvent to a specified target application.

seript @ errar string
target | cooooooed Do
send options seeenSorjed—— error

Script is a string containing instructions that the target application understands. It is
typically in a language specific to the target application. An example of an
application with a script language is Claris HyperCard.

target ID is a cluster of information describing the target application and its location.
See the Target ID section of this chapter for a further description of this cluster.

send options is a cluster that specifies whether the target application can interact
with the user and the length of the AppleEvent timeout. See the Send Options section
of this chapter for a discussion of the send options parameters.

error string describes error information.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.

AESend Finder Open

Sends the AppleEvent to open specified applications or documents to the System 7
Finder on the specified machine.

Full path of folder c-:untagning files

e Barmes E?[?n prnnnnnnn 2p g shing
O

cone containing Finder
Server containing Finder

send options

erFrar
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Full path of folder containing files describes the location of the folder that contains
the files for the Finder to open. This string must end in a colon (:).

file names is an array containing the names of the files in the folder described by Full
path of folder containing files. The Finder opens these files.

Zone containing Finder describes the AppleTalk zone where the target Finder
resides. If this string is empty, this VI assumes that the zone is the same as that of the
host Macintosh.

Server containing Finder describes the name of the Macintosh where the target
Finder resides. If this string is empty, this VI assumes that the server is the host
computer Finder.

send options is a cluster that specifies whether the Finder can interact with the user
and the length of the AppleEvent timeout. See the Send Options section of this
chapter for a discussion of the send options parameters.

error string describes error information.
error if negative, indicates a Macintosh error. If positive, error indicates an error

internal to the CIN that generated it. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.

Note: Apple may change the set of AppleEvents to which the Finder responds so

that they more closely conform to the standard set of AppleEvents. As a
result, the AppleEvent that AESend Finder Open sends to the Finder may
not be supported in future versions of the system software.

AESend Open

Sends the Open AppleEvent to a specified target application.

object specifier 5 i error string
target I soooeeeed Open
zend I:IFIt'i|:||'|5 l:l:l:l:l:l:l:l:lDb_'IE'Gt

errar

object specifier specifies the object that LabVIEW opens in the target application.
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target ID is a cluster of information describing the target application and its location.
See the Target ID section of this chapter for a further description of this cluster.

send options is a cluster that specifies whether the target application can interact
with the user and the length of the AppleEvent timeout. See the Send Options section
of this chapter for a discussion of the send options parameters.

error string describes error information.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.

AESend Open Document

Sends the Open Document AppleEvent to the specified target application, telling the
application to open the specified document.

full pathnarme of docurnent g error string

. larget [y sooooooc
zone containing -:Il:-cl.ﬂ'nen Open

server containing docurnent
send options

errar

full pathname of document describes the location of the document that the
application opens.

target ID is a cluster of information describing the target application and its
location. See the Target ID section of this chapter for a further description of this
cluster.

zone containing document describes the location of the document that the
application opens. Notice that the application and document can reside in different
locations. If zone containing document and server containing document are blank,
AESend Open Document assumes the document is on the host computer.

server containing document describes the location of the document that the
application opens. Notice that the application and document can reside in different
locations. If zone containing document and server containing document are blank,
AESend Open Document assumes the document is on the host computer.
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send options is a cluster that specifies whether the target application can interact
with the user and the length of the AppleEvent timeout. See the Send Options section
of this chapter for a discussion of the send options parameters.

error string describes error information.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.

AESend Print Document

Sends the Print Document AppleEvent to the specified target application, telling the
application to print the specified document.

full pathnarne of docurnent M E ] ;
o tar‘lﬂ_;e_lt IQ error =tring
zane containing docdment wannnnnn @
server cantaining docurnent
zend options

Eerrar

full pathnamg of document describes the location of the document that the
application prints.

target ID is a cluster of information describing the target application and its
location. See the Target ID section of this chapter for a further description of this
cluster.

zone containing document describes the location of the document that the
application prints. Notice that the application and document can reside in different
locations. If zone containing document and server containing document are blank,
the Print Documents AppleEvent assumes the document is on the host computer.

server containing document describes the location of the document that the
application prints. Notice that the application and document can reside in different
locations. If zone containing document and server containing document are blank,
the Print Documents AppleEvent assumes the document is on the host computer.
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send options is a cluster that specifies whether the target application can interact
with the user and the length of the AppleEvent timeout. See the Send Options section
of this chapter for a discussion of the send options parameters.

error string describes error information.
error if negative, indicates a Macintosh error. If positive, error indicates an error

internal to the CIN that generated it. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.

AESend Quit Application

Sends the Quit Application AppleEvent to a specified target application.

target |0 ooooooees %ﬁ prmnnnann o OF S0
gend optiong seeeoee] O ——— Brror

target ID is a cluster of information describing the target application and its location.
See the Target ID section of this chapter for a further description of this cluster.

send options is a cluster that specifies whether the target application can interact
with the user and the length of the AppleEvent timeout. See the Send Options section
of this chapter for a discussion of the send options parameters.

error string describes error information.
error if negative, indicates a Macintosh error. If positive, error indicates an error

internal to the CIN that generated it. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.
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LabVIEW Specific AppleEvent Vis

LabVIEW specific AppleEvent VIs send messages that only LabVIEW applications
(standard and run-time systems) recognize. To access the LabVIEW Specific Apple
Events VIs, pop up on the LabVIEW Specific Apple Events icon:

E@ E] LabYIEY Specific Apple Events

o T
apen,

Clase
CESIES

a5

You should use these VIs only when communicating with LabVIEW applications. You
can send these messages either to the current LabVIEW application or to a LabVIEW
application on a network. See the AppleEvent Error Codes section of Appendix B, Error
Codes for error information.

AESend Abort VI
Sends the Abort VI AppleEvent to the specified target LabVIEW application.

W1 name & T lnnnnnnn arror string
target IO oooooooo @
send oplions soooooen

errar

VI name is the actual name of the VI, not its pathname. The VI must already be open.
You can open the VI by using the AESend Open Document VI.

target ID is a cluster of information describing the target application and its location.
See the Target ID section of this chapter for a further description of this cluster.

gn.

send options is a cluster that specifies whether the target application can interact
with the user and the length of the AppleEvent timeout. See the Send Options section
of this chapter for a discussion of the send options parameters.

gn.

error string describes error information.
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error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. If error is 1000 the target VI is not running.
See the AppleEvent Error Codes section of Appendix B, Error Codes, for more
information.

AESend Close VI
Sends the Close VI AppleEvent to the specified target LabVIEW application.

M1 narne
target IO
save options
send options

ertrar =tring

errar

VI name is the actual name of the VI, not its pathname. The VI must already be open.
You can open the VI by using the AESend Open Document VI.

target ID is a cluster of information describing the target application and its location.
See the Target ID section of this chapter for a further description of this cluster.

save options is an integer value that determines what the target LabVIEW should do
if the VI has been modified. If save options has a value of 0, the target LabVIEW
prompts for a save. If save options has a value of 1, the target LabVIEW saves the
VI (if modified) without a prompt. If save options has a value of 2, the target
LabVIEW does not save the VI.

send options is a cluster that specifies whether the target application can interact
with the user and the length of the AppleEvent timeout. See the Send Options section
of this chapter for a discussion of the send options parameters.

error string describes error information.
error if negative, indicates a Macintosh error. If positive, error indicates an error

internal to the CIN that generated it. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.
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AESend Open, Run, Close VI

Uses the Open Document, Run VI, VI Active?, and Close VI AppleEvent VIs to make a
specified LabVIEW application open, run, and close a VI.

Full pathnarme of 1 %E error string
target IO M.DEE'*U. errar

For this VI, you must specify the complete pathname of the VI you want to run. See
Chapter 13, Path Controls and Refnums, of your LabVIEW User Manual for a
description of path controls and indicators available in the Controls palette.

Full pathname of VI describes the full path of the VI that LabVIEW opens, runs,
and closes.

target ID is a cluster of information describing the target application and its location.
See the Target ID section of this chapter for a further description of this cluster.

error string describes error information.
error if negative, indicates a Macintosh error. If positive, error indicates an error

internal to the CIN that generated it. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.

HE B E

AESend Run VI
Sends the Run VI AppleEvent to the target LabVIEW application.

M1 name T
target ID
send options :

VI name is the actual name of the VI, not its pathname. The VI must already be open.
You can open it by using the AESend Open Document VI.

ertar =tring

errar

target ID is a cluster of information describing the target application and its location.
See the Target ID section of this chapter for a further description of this cluster.
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send options is a cluster that specifies whether the target application can interact
with the user and the length of the AppleEvent timeout. See the Send Options section
of this chapter for a discussion of the send options parameters.

error string describes error information.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.

AESend VI Active?

Sends the VI Active? AppleEvent to the specified target LabVIEW application. VI
running? is a Boolean indicating whether the VI is currently executing.

W narne ansannnel @350 e, | I"LII'II'I'iI'Ig?
target ID prnnannan 21 OF StEiNG
send options B

VI name is the actual name of the VI, not its pathname. The VI must already be open.
You can open the VI by using the AESend Open Document VI.

target ID is a cluster of information describing the target application and its location.
See the Target ID section of this chapter for a further description of this cluster.

gn.

send options is a cluster that specifies whether the target application can interact
with the user and the length of the AppleEvent timeout. See the Send Options section
of this chapter for a discussion of the send options parameters.

gn.

VI running? is TRUE if the specified VI is currently running as a top level VL.
error string describes error information.
error if negative, indicates a Macintosh error. If positive, error indicates an error

internal to the CIN that generated it. See the AppleEvent Error Codes section of
Appendix B, Error Codes, for more information.

"
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Advanced Topics

Constructing and Sending Other AppleEvents

In addition to VIs that send common AppleEvents, you can use lower-level VIs to send
any AppleEvent. Using these VIs requires more knowledge of AppleEvents than using
the VIs described earlier in this chapter. If you are interested in using these VIs, you
should be familiar with the discussion of AppleEvents in Inside Macintosh, Volume VI,
and the AppleEvent Registry.

When sending an AppleEvent, you must include several pieces of information. The
event class and event ID identify the AppleEvent you are sending. The event class is a
four-letter code which identifies the AppleEvent group. For example, an event class of
core identifies an AppleEvent as belonging to the set of core AppleEvents. The event
ID is another four-letter code that identifies the specific AppleEvent that you wish to
send. For example, odoc is the four-letter code for the Open Documents AppleEvent,
one of the core AppleEvents. To send an AppleEvent using the AESend VI, concatenate
the event class and event ID together as an eight-character string. For example, to send
the Open Documents AppleEvent, pass the AESend VI the eight-character code
coreodoc.

If you are sending the AppleEvent to another application, you have to specify target ID
and send options, as described earlier in this chapter.

You can also specify an array of parameters if the target application needs additional
information to execute the specified AppleEvent. Because the data structure for
AppleEvent parameters is inconvenient for use in LabVIEW diagrams, the AESend VI
accepts these parameters as ASCII strings. These strings must conform to the grammar
described in the next section. You can use this grammar to describe any AppleEvent
parameter. The AESend VI interprets this string to create the appropriate data structure
for an AppleEvent, and then sends the event to the specified target.

Creating AppleEvent Parameters

In many cases, an AppleEvent parameter is a single value; however, it can be quite
complex, with a hierarchical structure containing components that in turn can contain
other components. In LabVIEW, a parameter is constructed as a string, which has a
simple grammar with which you can describe all kinds of data that an AppleEvent
parameter can be, including complex structures.

An AppleEvent parameter string begins with a keyword, a four-letter code describing the
parameter's meaning. For example, if the parameter is a direct parameter (one of the
most common types of parameters) you must specify that the keyword is a
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keyDirectObject by using the four-letter code - - - - (four dashes). Other examples
of keywords include savo, short for save options, which is used when sending the Close
VI AppleEvent to LabVIEW. Documentation detailing an application's supported
AppleEvents should indicate the keywords used for each parameter. See the Sending
AppleEvents to LabVIEW from Other Applications section of this chapter for a list of the
AppleEvents that you can use with LabVIEW.

Following the keyword, you must specify the parameter data as a string. You can use
AppleEvents with many different data types, including strings and numbers. When you
specify the data string, the AESend VI converts it to a desired data type based upon the
way the data is formatted and optional directives that can be embedded in the string.
Each piece of data has a four-letter type code associated with it, indicating its data type.
The target application uses this code to interpret the data. For example, if comma-
separated items are enclosed in brackets, a list of AE Descriptors is created, and the list
has a data type of 11 st; each of the comma-separated items could in turn be other items,
including lists.

You can use a number of VIs in the AppleEvents VI palette to create some of the more
common parameter strings, including aliases, which are used when referencing files in
parameters, and descriptor lists, which are used to specify a list of items as a parameter.
You can concatenate or cascade these strings together to create a more complex
parameter.
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Table 6-1 describes the format of AppleEvent descriptor strings and indicates VIs that
can create the descriptor, where appropriate.

Table 6-1.  AppleEvent Descriptor String Formats
To send data Format the string as: Parameter is | Examples: VI that can
as: of code type: construct string:
an integer A series of decimal digits, long or shor 1234 n/a
optionally preceded by a -5678
minus sign.
enumerated | A four-letter code. enum whos n/a
data If it is too long, it is '@all'
truncated; if it is too short, it long
is padded with spaces. If you >=
put single quotes (') around '86it'
it, it can contain any
characters; otherwise, it
cannot contain:
@':-,([{}])and cannot
begin with a digit.
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Table 6-1.  AppleEvent Descriptor String Formats (Continued)
To send data Format the string as: Parameter is | Examples: VI that can
as: of code type: construct string:
a string Enclose the desired TEXT “putxinto | n/a
sequence of characters card field
within open and close curly 5”
quotes (“entered with “Hi
option-[and” entered with There”
option-shift-[). Notice that
the string is not null-
terminated.
an AE Enclose a comma-separated | reco {x:100, AECreate
record list of elements in curly y:-100} Record
braces, where each element {'origin":
consists of a keyword (a {x:100,
typecode) followed by a y:-100},
colon, followed by a value, extent:
which can be any of the {x:500,
types listed in this table. y:5001},
cont:[1,5,
251}
an AE Enclose a comma-separated | list [123,-58, | AECreate
descriptor list of descriptors in square “test”’] Descriptor List
list brackets.
hex data Enclose an even number of | ?? (must be «015764 | (Hexdataisa
hex digits between French coerced —see | fe AB Cl»| component of
quotes («entered with next item) the string
option-\ and» entered with produced by
option-shift-\). Make Alias)
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Table 6-1.  AppleEvent Descriptor String Formats (Continued)
To send data Format the string as: Parameter is | Examples: VI that can
as: of code type: construct string:

some other | Embed data created inone of | The specified | sing(1234 | n/a

data type the types of this table in type code ) Make Alias
parentheses and put the alis(«hex | creates a hex
desired type code before it. If dump of dump of a file
the data is a numeric, an alias») | description.
LabVIEW coerces the data
to the specified type if n/a
possible and returns the . n/a
errAFCoercionFail error type(line)
code if it cannot. If the data rang{star:
is of a different type, 3, stop: 6}
LabVIEW replaces the old
typecode with the specified
type code.

null data Coerce an empty string tono | null ) n/a
type.
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Low-Level AppleEvent Vis

You can use the VIs in this section to construct AppleEvent parameters and send the
AppleEvent. The high-level VIs for sending AppleEvents, described earlier in this
chapter, are based on the AESend VI, and are good examples of creating AppleEvents
and their parameters.

To access the Low Level Apple Events palette, pop up on the Low Level Apple Events

icon:
M B[] Low Level Apple Event
' HMake Alias
&=
CE= Make
Send | Alias
G (el
Record)| 7520 || Epec.
| (&= |
creake| | Create| [ Create
Fange | |Cogical| [ Sormp.
Cesc. || s, || Dest.
AESend

Sends an AppleEvent specified in parameters to the specified target application.

requested reply parameters
Ewent Class and 1D EE eply pararmeters
pararneters Send ertor string
target 1D BFFOr
zend options

[abc] requested reply parameters is an array of strings containing a description of the
reply parameters you want. Each element should be an eight character string. The
first four characters constitute the keyword for the reply parameter. For example,
---- as a keyword specifies the direct object, or default parameter. The second four
characters are the type of the parameter. For example, bool means the parameter is
Boolean (TRUE or FALSE).

Event Class and ID is an eight character string containing two four character
substrings. The first four characters specify the event class. For example, you can use

© National Instruments Corporation 6-25 LabVIEW Communications VI Reference Manual



Chapter 6  AppleEvent Vis

T
r
o

aevt forthe Required Suite, or core for the Core Suite. The second four characters
specify the event ID. For example, you can use odoc for Open Document, or quit
for Quit.

parameters is an array of AppleEvent descriptor strings for the arguments sent in the
AppleEvent. The first four characters of each string are the keyword for the
parameter. For example, the primary argument is called the direct object and always
has the four character keyword ----. The descriptor string for that parameter
follows the first four characters.

target ID describes the application to which the AppleEvent is being sent. See the
Target ID section of this chapter for a further description of this cluster.

send options is a cluster describing options available for sending the AppleEvent.
The most important option is the Want reply option. If this boolean is TRUE, then
the AESend VI waits to receive a reply from the target application. See the Send
Options section of this chapter for a further description of send options cluster.

reply parameters is an output array of strings that corresponds to the input
requested reply parameters. Each string in this array is a descriptor string for the
reply parameter sent back by the target application.

error string usually gives a more meaningful description of errors that occur when
you send the AppleEvent.

error is the error number of any error that occurs when you send the AppleEvent.
Errors that occur when a parameter is incorrectly specified, have corresponding error
codes in the 12346 to 12364 range. In this case, the error string describes in more
detail what was wrong with the parameter. Errors in the range -1700 to -1732 indicate
that something went wrong in the creation, sending or receiving of the AppleEvent.
This can indicate a problem either in LabVIEW or in the target application. Errors in
the range -900 to -932 indicate that something went wrong at the AppleEvent
transport layer, the PPC Toolbox. This means the connection could not be established
between LabVIEW and the target application.
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Creates a unique description of a file from its pathname and location on the network.
You can use this description with the AESend VI when sending an AppleEvent that

refers to a file.
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File's full pathramne
Zone

Server name
alias kind
[0 minirmal alias)

Aliaz (aliz) AESend descriptor

errar

Make
Alias

An alias is a data structure used by the Macintosh toolbox to describe file system objects
(files, directories and volumes). Do not confuse this with a Finder™ alias file. A
minimal alias contains a full path name to the file and possibly the zone and server that
the file resides on. A full alias contains more information, such as creation date, file
type, and creator. (The complete description of the structure of an alias is confidential
to Apple Computer.) Aliases are the most common way to specify a file system object
as a parameter to an AppleEvent.

File’s full pathname describes the file or folder. It includes any information about
where the file or folder resides on the network.

Zone is the AppleTalk zone where the server machine resides. If Server name is
empty this string is unused.

Server name is the name of the machine where the file or folder resides

alias kind describes the alias. The possible values are:

0:

Minimal alias. Uses Zone and Server. You cannot use it in an
AppleEvent sent to the Finder™. The VI creates the alias from scratch,
and does not check to see whether the file actually exists or is accessible
from the desktop. It must have a volume name with a colon following it.
Full alias. Ignores Zone and Server. You can use it in AppleEvents sent
to any application, including the Finder™. The VI creates this alias
from scratch. If the file does not exist or is not accessible from the
desktop, it returns an error.

From Finder™ alias file. Ignores Zone and Server. You can use it in
AppleEvents sent to any application, including the Finder™. File's full
pathname specifies a Finder™ alias file that points to the specific file.
Finder™ alias files contain full aliases, and does not check to see
whether the file actually exists or is accessible from the desktop. The
VI copies the contents of the alias file to create the output alias.
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Alias is the AppleEvent descriptor string.

error describes any errors that occur.

Creating AppleEvent Parameters Using Object Specifiers

Apple has created a high-level interface for creating AppleEvents called the Object
Support Library. This interface is actually layered on top of the AppleEvent parameter
data structures described earlier in this chapter. This interface helps create common
types of parameters, including range specifications. LabVIEW object support VIs are
located on the Low Level Apple Events pop up palette.

AECreate Comp Descriptor
Creates a string describing an AppleEvent comparison record, which specifies how to
compare AppleEvent objects with another AppleEvent object or a descriptor record.

corparison operator Mk =)
operand 1 reale comparizon descriptor
operand 2 Dest.

For example, you can use the output comparison descriptor string as an argument to the
AESend VI, or as an argument to AECreate Object Specifier to build a more complex
descriptor string. See the Object Support VI Example section of this chapter for an
example of its use.

comparison operator is a descriptor type string that describes the comparison
operation to perform on the operands. The standard set of comparisons are:

> kAEGreaterThan-The value of operandl is greater than the value
of operand 2.
>= kAEGreaterThanEquals-The value of operandl is greater than or
equal to the value of operand 2.
= kAEEquals-The value of operand 1 is equal to the value of operand
2.
< kAELessThan-The value of operand 1 is less than the value of
operand 2.
<= kAELessThanEquals-The value of operandl is less than or equal
to the value of operand 2.
bgwt kAEBeginsWith-The value of operand 1 begins with the value of
operand 2 (for example, the string operand begins with the string
opera).
ends kAEEndsWith-The value of operandl ends with the value of
operand 2. For example, the string operand ends with the string and.
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cont kAEContains-The value of operand1 contains the value of operand
2. For example, the string operand contains the string era.

operand 1 is an AppleEvent object specifier descriptor string. It specifies the first
object in the comparison to perform.

operand 2 is an AppleEvent record descriptor string. It can be an object specifier
descriptor string or any other record descriptor string with a value to compare to the
value of operand 1.

comparison descriptor is the AppleEvent descriptor string.

AECreate Logical Descriptor

Creates a string describing an AppleEvent logical descriptor, which you use with the
AESend VI.

i J—
lagical operator bt
Loqgical
Cesc.

logical descriptor

lagical terms
[AEDesc ar AEDescList)

AppleEvent logical records describe logical, or Boolean expressions of multiple terms,
such as the AND of two AppleEvent comparison records. For example, you can use the
output logical descriptor string as an argument to the AESend VI, or as an argument to
AECreate Object Specifier VI to build a more complex descriptor string. See the Object
Support VI Example in this chapter for an example of its use.

logical operator is a string describing the logical operation. The possible values are
AND, OR, and NOT.

logical terms is an AppleEvent list descriptor string, such as the output by the
AECreate Descriptor List VI. If the value of logical operator is AND or OR, this list
can have any number of elements. If the value of logical operator is NOT, this list
has only a single element.

logical descriptor is an AppleEvent descriptor string created from the inputs.
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AECreate Object Specifier
Creates a string describing an AppleEvent object, which you use with the AESend VI.

clazs D & =
container mnenmannl Seaate
key form [0 memeeeeaf Shiect
key data nnnnanan] Spec,

Ob ject specifier

An object specifier is an AppleEvent record whose type is obj and describes a specific
object. It has four elements: the class of the object, the containing object, a code
indicating the form of the description, and the description of the object.

class ID is a string that describes the class of the specified object. Examples of such
strings are: ccel for class Cell, ccol for class Column, and ctbl for class Table
(from the Table Suite of AppleEvents); and c¢DB for the class DataBase (from the
DataBase Suite of AppleEvents).

container is an AppleEvent object specifier descriptor string that describes the
containing object of the specified object. It should be another object specifier that
this VI creates. If this string is left empty (the default value), the NULL object
specifier is the container, and signifies the target application, which is the outermost
container of any object specifier.

Tabe | key form ID is a string describing the form of the key data. It tells how to interpret
the key data. The standard key forms are:

prop FormPropertyID means that the key data is the name of a property.
name FormName means that the key data is the name of the object.
ID FormUniqueID means that the key data is a unique identifier for the

object.

indx FormAbsolutePosition means that the key data is a descriptor
string for either a positive integer, indicating the offset of the requested
element from the beginning of the container, or a negative integer,
indicating its offset from the end of the container. The key data can also
be a descriptor string for an absolute ordinal (type abso) with one of
the following values: firs, last, midd, any, or all.

rele FormRelativePosition means the key data is a descriptor string
for a relative position (type enum) with a value of next or prev.

test FormTest means the key data is a descriptor string for either a
comparison record or a logical record (as created by either the
AECreate Comp Descriptor VI or the AECreate Logical Descriptor VI).

rang FormRange means the key data is a descriptor string for a range
descriptor record (as created by the AECreate Range Descriptor VI.)
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key daFa Isa string describing the object. The value of the key form ID parameter
determines its value.

Object specifier is the output descriptor string that the given inputs create. You can
use it as the input for calls to the AECreate Object Specifier VI or anywhere that
requires an object specifier.

AECreate Range Descriptor

Creates a string describing an AppleEvent range descriptor record, which you use with
the AESend VI.

range start ]
Fange descriptor

range stop

Range descriptor records are used in object specifiers whose key form is formRange
(rang). They describe a range of objects with two object specifiers: the start and the
end of the range

range start is an object specifier descriptor string that describes the beginning of the
range.

range stop is a object specifier descriptor string that describes the end of the range.

range descriptor is the output descriptor string that the given inputs create.
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AECreate Descriptor List
Creates a string describing a list of AppleEvent descriptors, which you can then use with
the AESend VI. You commonly use Descriptor lists when you create the operands for a
logical descriptor

& =

drray of AE Descriptors Greate #E Descriptor List

List

[abe] Array of AE Descriptors should contain AppleEvent descriptor strings, such as

those output by the AECreate... series of AppleEvent VlIs.

AE Descriptor List is an AppleEvent descriptor string with the correct syntax for a
list of all the descriptors from the Array of AE Descriptors input array.

AECreate Record
Creates a string describing an AppleEvent descriptor record, which can then be used
with the AESend VI. You can use a record descriptor to bundle descriptors of different
types. Each descriptor has its own keyword, or name, and value

type i T
4F create AE Record
keywards and values emmmrFecord

type is a descriptor type string that describes the type of the AppleEvent record
descriptor. Only the first four characters are significant, however it is acceptable to
have more or less than four characters.

keywords and values is an array of clusters containing the strings that describe the
:
elements of the record being created.

keywords is a descriptor type string that is the name of the record
element. Only the first four characters are significant.

values is an AppleEvent descriptor string that is the value of the record

element. It can be any descriptor string, such as those output by the
AECreate... series of AppleEvent VlIs.
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AE Record is an AppleEvent record descriptor string created from the inputs. Other
VIs requiring an AppleEvent descriptor string input can use this string.

Object Support VI Example
The following example creates an AppleEvent parameter using the object support VIs.
This example creates an AppleEvent parameter to be sent to a word processor, asking
the word processor to return the first line of a specified document whose first word is
April and whose second word is is.
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The following string that the previous diagram creates is quite complicated; tabs are
added to make the string easier to read. For further information about the Object Support
Library consult the AppleEvent Registry.

obj {

want: type(‘'line’),
from: obj {

want: type('line'),
from: Doc Name,
form: test,

seld: logi {

term: [

cmpd {

relo:=,
objl:“April~”,
obj2:0bj {

want: type('word'),
from: exmn( ),
form: indx,

seld: 1

}

I

cmpd {

relo:=,

objl:%“is”,

obj2:0bj {

want: type('word'),
from: exmn( ),
form: indx,

seld: 2

}

}

1,
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logc: AND
}

T,

form: indx,
seld: 1

}

Sending AppleEvents to LabVIEW from Other

Applications

LabVIEW responds to required AppleEvents, which Apple expects all
System 7 applications to support, and to LabVIEW specific
AppleEvents, designed specifically for LabVIEW. Both categories are
described in the following sections.

Required AppleEvents

LabVIEW responds to the required AppleEvents, which are Open
Application, Open Documents, Print Documents, and Quit
Application. These events are described in Inside Macintosh, Volume
VI

LabVIEW Specific AppleEvents

LabVIEW also responds to the LabVIEW specific AppleEvents Run
VI, Abort VI, VI Active?, and Close VI. With these events and the
Open Documents AppleEvent, you can use other applications to
programmatically tell LabVIEW to open a VI, run it, and close it when
it is finished. A thorough understanding of AppleEvents, as described
in Inside Macintosh, Volume VI, and the AppleEvent Registry is a
prerequisite for sending these AppleEvents to LabVIEW from other
applications. You can send these events between two or more
LabVIEW applications by using the utility VIs described in the
Sending AppleEvents section in Chapter 1, Communication
Applications in LabVIEW.

The LabVIEW specific AppleEvents are described in later sections, in
a format similar to that used in the AppleEvent Registry.
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Replies to AppleEvents

If LabVIEW is unable to perform an AppleEvent, the reply will contain
an error code. If the error is not a standard AppleEvent error, the reply
will also contain a string describing the error. Appendix B, Error
Codes, summarizes the LabVIEW specific errors that can be returned
in a reply to an AppleEvent.

Event: Run VI

Description

Tells LabVIEW to run the specified VI(s). Before executing this event,
the LabVIEW application must be running, and the VI must be open
(you can open the VI using the Open Documents AppleEvent).

Event Class

LBVW (Custom events use the Applications creator type for the
event class)

Event ID
GoVI ----

Event Parameters

Description Keyword Default Type

VI or List of VIs keyDirectObject(----)typeChar (char)
(required) or list of
typeChar (list)

Reply Parameters

Description Keyword Default Type
none

Possible Errors
Error Value Description

kLVE_InvalidState 1000 The VIisin a state that does
not allow it to run.

kLVE_FPNotOpen 1001 The VI front panel is not
open.
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kLVE_CtrlErr 1002 The VI has controls on its
front panel that are in an
error state.

kLVE_VIBad 1003 The VI is broken.
kLVE_NotInMem 1004 The VI is not in memory.
Event: Abort VI

Description

Tells LabVIEW to abort the specified VI(s). Before executing this
event, the LabVIEW application must be running, and the VI must be
open (you can open the VI using the Open Documents AppleEvent).
This message can only be sent to VIs that are executed from the top
level (subVlIs are aborted only if the calling VI is aborted).

Event Class

LBVW (Custom events use the Applications creator type for the
event class)

Event ID
RsVI

Event Parameters

Description Keyword Default Type

VI or List of VIs keyDirectObject (----)typeChar (char)
(required) or list of
typeChar (list)

Reply Parameters

Description Required? Keyword Default Type
none

Possible Errors
Error Value Description

kLVE_InvalidState 1000 The VIis in a state that does
not allow it to run.
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kLVE_FPNotOpen 1001 The VI front panel is not
open.
kLVE_NotInMem 1004 The VI is not in memory.

Event: VI Active?

Description

Requests information on whether a specific VI is currently running.
Before executing this event, the LabVIEW application must be
running, and the VI must be open (you can open the VI using the Open
Documents AppleEvent). The reply indicates whether the VI is
currently running.

Event Class

LBVW (Custom events use the Applications creator type for the
event class)

Event ID
VIAc

Event Parameters

Description Keyword Default Type
VI Name keyDirectObject (----)typeChar (char)
(required)

Reply Parameters

Description Keyword Default Type
Active? keyDirectObject (----)typeBoolean
(required) (bool)

Possible Errors

Error Value Description

kAEvVtErrFPNotOpen 1001 The VI's front panel is not
open.

kLVE_NotInMem 1004 The VI is not in memory.
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Event: Close VI

Description

Tells LabVIEW to close the specified VI(s). Before executing this
event, the LabVIEW application must be running, and the VI must be
open (you can open the VI using the Open Documents AppleEvent).

Event Class

LBVW (Custom events use the Applications creator type for the
event class)

Event ID
CIVI

Event Parameters

Description Keyword Default Type

VI or List of VIs keyDirectObject (----)typeChar (char)
(required) or list of
typeChar (list)

Save Options keyAESaveOptions (savo)typeEnum

(not required) (enum)
possible values:
yes and no

Reply Parameters

Description Keyword Default Type
none

Possible Errors

Error Value Description

kAEVtErrFPNotOpen 1001 The VI's front panel is not
open.

kLVE_NotInMem 1004 The VI is not in memory.

cancelError 43 The user cancelled the close
operation.
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Program to Program
Communication Vls

This chapter describes the LabVIEW VIs for Program to Program
Communication (PPC), a low-level form of Apple interapplication
communication (IAC) by which Macintosh applications send and
receive blocks of data.

The following illustration shows the PPC VI palette, which you access
by selecting Functions» Communication»PPC:
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End Close || Cloze

For examples of how to use the PPC VIs, see the examples located in
examples\comm\PPC Examples.llb.
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You can find helpful information about individual VIs online by using
the LabVIEW Help window (Help»Show Help). When you place the
cursor on a VI icon, the wiring diagram and parameter names for that
VI appear in the Help window. You can also find information for front
panel controls or indicators by placing the cursor over the control or
indicator with the Help window open. For more information on the
LabVIEW Help window, refer to the Gerting Help section in Chapter 2,
Creating Vs, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online
¢ information available. To access this information, select Help»Online
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Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online
description. You can also access this information by pressing the
button shown to the left, which is located at the bottom of LabVIEW’s
Help window. For information on creating your own online reference
files, see the Creating Your Own Help Files section in Chapter 25,
Managing Your Applications, of the LabVIEW User Manual.

Introduction

PPC is a higher performance protocol than Apple Events because PPC
requires less overhead to transmit information. However, because PPC
does not define the form or meaning of information that it transfers, it
is more complicated to use and many applications do not support it.

LabVIEW VIs can use PPC to send and receive large amounts of
information between applications on the same computer or different
computers on a network. For two applications to communicate with
PPC, they must both be running and prepared to send or receive
information. To launch an application remotely, you can use the
AESend Finder Open VI, which is described in the AppleEvents section
of Chapter 1, Communication Applications in LabVIEW.

General PPC Behavior

To communicate using PPC, each application must open a named port,
over which communication sessions are established, as shown in
Figure 7-1. The application that requests communication is the client;
and the application with which the client communicates is the server.
The server application makes its availability known by issuing a PPC
Inform Session operation. The client requests a session with the server
application, which can either accept or reject the request. If the server
application accepts the request, then the system establishes a session
and the two applications can send and receive blocks of information
between them. When the applications finish communicating, you
should end the session. You may also want to close the port if you do
not want to establish more sessions with that port.

You use the PPC Open Port VI to open a port for communication. PPC
Open Port returns a port reference number, which you use in
subsequent operations relating to that port. You can have multiple ports
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open simultaneously, as long as they each have a different name. Each
port can support multiple sessions.

You can initiate a session using the PPC Start Session VI. You pass
PPC Start Session a target ID (see the General Apple Event VI
Behavior section of Chapter 6, Apple Event VIs) and the port reference
number through which you want to communicate. If the target
application accepts the session, PPC Start Session returns a session
reference number, which you use in subsequent communication for that
session. PPC Start Session also incorporates an authentication
(password) mechanism.

To receive session requests, use the PPC Inform Session VI. You can
configure this VI to accept all requests automatically, or you can
decide whether to accept or reject the request based on the information
about the requesting application that this VI returns. You should accept
or reject the request using the PPC Accept Session VI immediately,
because the other computer waits (hangs) until you accept or reject its
attempt to initiate a session, or until an error occurs.

When a session is established, you can use the PPC Write and PPC

Read VIs to communicate with the other application. When you are
finished with a session, you should execute the PPC End Session VI
and close the port using the PPC Close Port VI.
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Figure 7-1 illustrates the order in which you use the PPC VIs.
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Figure 7-1. PPC VI Execution Order (Used by permission of Apple Computer, Inc.)
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PPC VI Descriptions

PPC Accept Session

Accepts or rejects a PPC session request based on the Boolean accept?.

session refnum ﬁ@— zession refnum output

HCCE'FIt? ET:' T e t7
reject info — | al error

You should accept or reject the request using the PPC Accept Session VI immediately,
because the other computer waits (hangs) until the VI accepts or rejects its attempt to
initiate a session or an error occurs.

session refnum is a session reference number, which you use in subsequent
communication for this session.

= accept? (T) determines whether the VI accepts or rejects a PPC session.

reject info contains an application-defined value you return if you reject a session.

session refnum output is the same value as session refnum if accept? is TRUE.
Otherwise, the value of session refnum output is 0.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See Appendix B, Error Codes, for a list of PPC
error codes and their descriptions.

§ HEE E

PPC Browser

For information on the PPC Browser VI, see Chapter 6, Apple Events VIs, of this manual.
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Close All PPC Ports
Closes all the PPC ports that the PPC Open Port VI opened.

E.II:IEE' I':'I]] I:.tr-uej ................ %%'

Closing a port terminates all outstanding calls associated with the port with a
portClosedErr (error -916).

You can use the Close All PPC Ports to handle abnormal conditions that leave ports
open. An example of an abnormal condition is when a VI is aborted before it can
terminate normally and close the PPC port. You can use the Close All PPC Ports VI
during VI development, when such mistakes are more likely to be made, or as a
precaution at the beginning of any program that opens ports.

Close All (true) if TRUE closes all the ports that the PPC Open Port VI opened.

PPC Close Port
Closes the specified PPC port.

ChE

Cloze

port refnum ertar

Closing a port terminates all outstanding calls associated with the port with a
portClosedErr (error -916).

port refnum is a unique port reference number.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See Appendix B, Error Codes, for a list of PPC
error codes and their descriptions.
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PPC End Session

Ends the specified PPC session.

Fxe

End

zession refnum errar

Ending a session causes all outstanding calls associated with the session (PPC Read and
PPC Write calls) to finish with a sessClosedErr (error -917).

session refnum is a session reference number, which you use in subsequent
communication for this session.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See Appendix B, Error Codes, for a list of PPC
error codes and their descriptions.

Get Target ID

For information on the Get Target ID VI, see Chapter 6, Apple Event VlIs, of this manual.

PPC Inform Session

Waits for a PPC session request.

Itnf .
timeout ticks (0 no tirmeout)] — " Drm%r‘equeﬂ infa

port refnum ﬂ@' session refnum
autormnatically accept (T) - ' o initiator's target D

erFar

port refnum contains the unique port reference number identifying the port the VI
closes if a timeout occurs or if the VI aborts before completing execution.

automatically accept (T) if TRUE causes the VI to automatically accept any session
request. Otherwise, accept or reject the request using the PPC Accept Session VI
immediately, because the other computer waits (hangs) until the VI accepts or rejects
its attempt to initiate a session or an error occurs.
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timeout ticks if non-zero specifies the number of ticks PPC Inform Session waits
for LabVIEW to establish a session before returning the errTimedOut error. One tick
equals 1/60 of a second.

session refnum is a session reference number, which you use in subsequent
communication for this session.

- initiator’s target ID describes the application attempting to start a session.

request info is a cluster containing information about the user attempting to start a
session. request info contains the following parameters in the order listed.

user name, a string, is the name of the user that is attempting to start a
session.

user data is an application-defined value that is the same as the user

data value passed to PPC Start Session.

request origin indicates the origin of the application requesting a

session.
1: (Local Origin) The requesting application is on the same
computer.
2: (Remote Origin) The requesting application is remote.

37 service type is a ring indicator. The service type is always 1
(Real Time) for the current version of Apple PPC protocol.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See Appendix B, Error Codes, for a list of PPC

error codes and their descriptions.
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PPC Open Port

Opens a port for PPC communication and returns a unique port reference number in port
refnum. You can use a single port for multiple sessions.

porthame ﬁ ﬁ— port refnum
alias location name =~
__________ opel f— aprar

netwark visible (falze) -

When opening a port using PPC Open Port, you must specify a portName cluster.

port type stringll o |

was registered
on netwoark

alias location namel

network
vizible

[false)

portName is a cluster containing the following parameters in the order listed below.

nameScript is a 32-bit integer used in international localization that
specifies the language system you are using. Use a nameScript value of
0 for Roman language systems (for example, English); consult Inside
Macintosh, Volume VI for a list of available script codes.

selector describes the format of the type string parameter.
1: (creator/type) Signifies that type string is an 8-character

string; the first four characters are the creator (for
example, LBVW), and the last four characters define the

port type.
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T

2: (port type string) Signifies that type string is a
32-character (or less) description of the service provided
by the port .

port type string is an 8-character string; the first four characters are the
creator (for example, LBVW), and the last four characters define the
port type, when selector has a value of 1. The type string is a 32-
character (or less) description of the service that the port provides when
selector has a value of 2. (In almost all cases, you should specify a value
of 2 for selector, and use a description of the service provided by the
port for type string. Consult Inside Macintosh, Volume VI, for more
information about other cases.)

name is the name you give to the port. The value of name, which can
be no more than 32 characters, is displayed in the PPC Browser dialog
box list of port names. The Get Target ID VI uses name to identify the
port.

alias location name establishes an alias name for the port. The PPC
Browser uses this alias to determine which machines to display in its
dialog box. If you leave this string empty the VI uses the default alias
PPCToolBox.

network visible determines whether the port is accessible to other machines on the

network.

port refnum is a port reference number, which you use in subsequent operations
relating to that port.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See Appendix B, Error Codes, for a list of PPC
error codes and their descriptions.
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PPC Read

Reads a block of information from a specified session. If a timeout occurs or the VI
aborts before completing execution, the port that port refnum represents closes.
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seszion refnum | data bytes
n by tes o read %&?m . ................ data info
tirneout ticks (0 no timeaut) 2 SFFOF

pall wait (10 mz)

PPC Read executes asynchronously by starting to read the specified data and then
polling until the read is finished.

session refnum is a session reference number, which you use in subsequent
communication for this session.

n bytes to read specifies the number of bytes the VI reads.

timeout ticks value, if non-zero, specifies the number of ticks the PPC Inform
Session VI waits for a session to be established before returning the errTimedOut
error. One tick equals 1/60 of a second.

poll wait (10 ms) determines how frequently PPC Read checks to see whether
LabVIEW has read the data successfully.

data bytes is an array of unsigned 8-bit integers that is written by the sender.

data info is a cluster of application-specific information that LabVIEW uses when
reading and writing blocks of data in a PPC session. This cluster contains three 32-
bit integers: block creator, block type, and user data. You can use these values to
send information about the block of data to the receiving application.

more is a Boolean indicating whether more data exists for the given block that the
VI reads. The application that writes the data can send the data in multiple pieces.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See Appendix B, Error Codes, for a list of PPC
error codes and their descriptions.
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PPC Start Session

Attempts to start a session with the application specified by target ID through the
specified port. If a timeout occurs or the VI aborts before completing execution, the port
represented by port refnum closes.

tirmeout ticks [0 no tirmeout) —_I_I_
part refniurn session refhun
tar’??t |% mﬁﬁ rE‘jE‘Ct info

user dafa (0
Allow Drialog Cirue errar

prompt mnnmnnnnnnt

timeout ticks (0: no timeout) if non-zero specifies the number of ticks PPC Inform
Session waits for a session to be established before returning the errTimedOut error.
One tick equals 1/60 of a second.

g

port refnum is a unique reference number that specifies the port through which
LabVIEW attempts to start a session with the application.

target ID is a cluster of information describing the target application and its location.

user data is an application-defined value that the VI sends with the request for a
session.

Allow Dialog (true) if TRUE displays the User Identity Dialog Box if the target
application requires authorization.

-

{ B EE B EH E

prompt appears in the dialog box.

session refnum is a session reference number, which you use in subsequent
communication for this session.

reject info contains an application-defined number if the target application rejects
the request.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See Appendix B, Error Codes, for a list of PPC
error codes and their descriptions.
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PPC Write

Writes a block of information to the specified session. If a timeout occurs or the VI
aborts before completing execution, the port represented by port refnum is closed. PPC
Write executes asynchronously by starting to write the specified data and then polling
until the write is finished.

tirmeout ticks (0 no tirmeout)

59551;:|I:|ntr'elh:lfn:m _|— i;i ﬁ— length written
ata bytes=s -
data info mﬂm Wte [ cprar

moare

poll wait (10 ms)

timeout ticks if non-zero specifies the number of ticks the PPC Inform Session VI
waits for LabVIEW to establish a session before returning the errTimedOut error.
One tick equals 1/60 of a second.

session refnum is a session reference number, which you use in subsequent
communication for this session.

e

data bytes is an array of unsigned 8-bit integers to send to the target application.

—
=
-]

—

data info is a cluster of application-specific information you use when reading and
writing blocks of data in a PPC session. data info contains three 32-bit integers:
block creator, block type, and user data. You can use these values to give
information about the block of data to the receiving application.

more should be TRUE if you want to write more data for a given block. For example,
if you want to write a block of data in several calls to PPC Write, set more to TRUE
on all but the last write of the sequence.

I
"

poll wait (10 ms) determines how frequently PPC Write checks to see whether
LabVIEW has written the data successfully; for higher throughput, a value of zero is
best.

g

length written is the actual number of bytes written. Except when the VI returns an
error, length written should always be the length of the byte array input.

error if negative, indicates a Macintosh error. If positive, error indicates an error
internal to the CIN that generated it. See Appendix B, Error Codes, for a list of PPC
error codes and their descriptions.
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Communications Common
Questions

This appendix answers common questions about LabVIEW and
networking communications. Questions are divided into sections
according to the relevant platform: All, Windows, and Macintosh.
Please contact National Instruments if you have further questions or
suggestions regarding LabVIEW.

Questions for All Platforms

How do | use LabVIEW to communicate with other
applications?

Communicating with other applications, often called interprocess or
interapplication communication, can be done with the standard
networking protocols on each platform. LabVIEW has support for TCP
(Transmission Control Protocol) and UDP (User Datagram Protocol)
on all platforms.

Windows

In addition, LabVIEW for Windows supports DDE (Dynamic Data
Exchange).

Macintosh

In addition, LabVIEW for Macintosh supports IAC (Interapplication
Communication). IAC includes Apple Events and PPC (Program to
Program Communication).

Sun and HP-UX
LabVIEW for Sun and HP-UX only support TCP and UDP.

The LabVIEW Communications VI Reference Manual provides further
information on how use LabVIEW to communicate with other
applications. In addition, for many instrumentation applications,

file I/O provides a simple, adequate method of sending information
between applications.
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Windows Only

How do I launch another application with LabVIEW?

On Windows, Sun and HP-UX, use System Exec.vi
(Utilities->System). On Macintosh, use AESend Finder
Open (Network->AppleEvents VIs).

When would | want to use UDP instead of TCP?

Typically, UDP is used in applications where reliability is not critical.
For example, an application might transmit informative data to a
destination frequently enough that a few lost segments of data are not
problematic. Also, UDP can be used to broadcast to any machine(s)
wanting to listen to the server.

What port numbers can | use with TCP and UDP?

A port is represented by a number between 0 and 65535. With UNIX,
port numbers less than 1024 are reserved for privileged applications
(e.g. ftp). When you specify a local port, you can use the value of 0
which would cause TCP and UDP to choose an unused port.

Why can’t | broadcast using UDP?

Since the broadcast address varies among domains, you will need to
find out from your system administrator what broadcast address to use.
For example, the broadcast address OxFFFFFFFF will not be correct
for your domain. Additionally, your machine may default to not allow
broadcasting unless the process is run by the root user.

What winsock.dll can | use with LabVIEW?

This question pertains to Windows 3.x only, as Windows 95 and
Windows NT include this file in their operating systems.

Any WinSock driver that conforms to standard 1.1 should work with
LabVIEW. Information regarding National Instruments’ in-house
testing of winsock.d11ls can be found in your online Release Notes.

Recommended:

e TCPOpen version 1.2.2 from Lanera Corporation
(408) 956-8344.
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*  Trumpet (version 1.0 tested). Available via anonymous ftp to
ftp.utas.edu.au in the directory /pc/trumpet/
winsock/ *. For information send electronic mail to trumpet -
info@petros.psychol.utas.edu.au.

e Super-TCP version 3.0 R1 from Frontier Technologies
Corporation (414) 241-4555.

e NEWT/Chameleon version 3.11 from NetManage, Inc.
(408) 973-7171.

*  Windows for Workgroups winsock.dll from Microsoft.

Not Recommended:

National Instruments’ limited testing of these products yielded various
problems and crashes while attempting TCP/IP communication. At this
time we can neither recommend these products nor support customers
attempting TCP/IP communication with these winsock.d11s.

e Distinct TCP/IP version 3.1 from Distinct Corporation
(408) 741-0781.

e PCTCP version 2.x from FTP Software, Inc. (508) 685-4000.

How do I call an Excel macro using DDE?

Use DDE Execute.vi. This VI tells the DDE server to execute a
command string in which you specify the action for Excel to perform
and the name of the macro. Make sure to include the correct
parentheses and brackets around the command. Refer to the Excel
User’s Guide for more information. Some common examples are
shown below:

Command String Action
[RUN ("MACRO1") ] Runs MACRO1
[RUN("MACROL1!R1C1")] Runs MACROI starting at
Row 1, Column 1
[OPEN ("C:\EXCEL\SURVEY.XLS") ] Opens SURVEY . XLS

Why doesn't DDE Poke work with Microsoft Access?

Microsoft Access cannot accept data directly from DDE clients. To get
data into an Access database you must create a macro in that database
to import the data from a file. In the simple case these macros need
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only be two actions long. First do a SetWarnings to suppress Access
dialogs, then do a TransferSpreadsheet or TransferText to get the data.
After this macro is defined, you can call the macro by sending an
execute to that database with the macro name as the data. Refer to the
example VI Sending Data to Access.vi located in
examples\network\access.1l1b to see how this is done.

What commands do | use to communicate with a non-
LabVIEW application using DDE?

The DDE commands are specific to the application with which you are
interfacing. Consult the User’s Manual or online reference for the
specific application to see which commands are available.

How do | install LabVIEW as a shared application on a file
server?

Provided the user has a license for each client, the process is as
follows:

e Install the LabVIEW Full Development System on the server.
(Unless there is NI hardware on the server, it is not necessary to
install NI-DAQ or GPIB.DLL).

* Each local machine should use its own labview. ini file for
LabVIEW preferences. If a labview. ini file does not already
exist on the local machine, you can create this (empty) text
document using a text editor, such as Microsoft Notepad. The first
line of labview.ini must be [labview]. To have alocal
setting for labview. ini, LabVIEW requires a command line
argument containing the path to the preferences. For example, if
the labview. exe file is on drive W: \LABVIEW and the
labview.ini fileison C:\LVWORK (the hard drive on the
local machine), modify the command line option of the LabVIEW
icon in Program Manager to be:

W:\LABVIEW\LABVIEW.EXE -pref
C:\LVWORK\LABVIEW.INTI

Note: pref must be lower case. Additionally, each local machine
must have its own LabVIEW temporary directory. This is done in
LabVIEW by choosing Edit»Preferences....

*  Youdonotneed GPIB.DLL on the server machine, unless you are
using a GPIB board on this machine. You will need the gpibdrv
file in the LabVIEW directory. Then, on each machine that has a
GPIB board, you will need to install the driver for that board. You
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can do this by either using the drivers that came with the board, or
by doing a custom LabVIEW installation, in which only the
desired GPIB driver is installed on the local machine.

e The same procedure for GPIB.DLL applies to NI-DAQ.

Why does the Synch DDE Client / Server hang on NT after
many transfers?

There are some problems with DDE in LabVIEW for NT that result in
VIs hanging during DDE Poke and DDE Request operations. This
limitation is specific to Windows NT.

Are there plans for LabVIEW to support OLE?

OLE (Object Linking and Embedding) is a way of embedding objects
from one application into another application. For example, a
spreadsheet might be included on a word processing document. When
the text document is loaded, the current values that are found in the
spreadsheet are automatically included into the document. We are
currently investigating support for OLE for a future version of
LabVIEW; however, no dates have been set on when a version
including OLE support will be available.

OLE Automation is a technique by which Automation servers can
expose methods and properties to other applications and Automation
controllers can access the methods and properties of other applications.
LabVIEW 4.x is an OLE Automation controller. There is a library of
VIs which you can use to execute properties and methods exposed by
Automation servers.

Macintosh Only

What is a target ID?

Target ID is used in the Apple Events and PPC VIs on the Macintosh;
it serves as a reference to the application that you are trying to launch,
run, or abort. The target ID to an application can be accessed by one of
the following commands:

Get Target ID - takes the name and location of the application as
input, searches the network for it, and returns the target ID;

PPC Browser - pops up a dialog box that allows you to select an
application, which may be across the network or on your computer.
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The target ID you generated at the beginning of your VI should be used
as an input to all subsequent Apple Event functions to open, print,
close, or run the application.

Why can't | see my application in the dialog box generated
by PPC Browser?

If the application you want to connect cannot be used with Apple
Events, it will not show up in the PPC Browser dialog box. If you
are certain that the desired application supports Apple Events, make
sure that the Macintosh has File Sharing turned on. Go to Control
Panels and select Sharing Setup to turn File Sharing on.

How can | close the Finder using Apple Events?

Use the VI AESend Quit Application to quit the Finder or any
other application.
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Error Codes

This appendix lists the error codes returned by LabVIEW functions,
including the name and description of each code.

PPC Error Codes

The following table lists the PPC error codes and their descriptions.
Errors that PPC VIs return with negative values are Macintosh Toolbox
errors, and are listed in Table B-1 below. Errors that PPC VIs return
with a positive value are LabVIEW specific PPC errors. See Table B-3
of this appendix for a listing of LabVIEW Specific PPC Error Codes.

Table B-1. PPC Error Codes

Code Name Description

-900 notInitErr PPC Toolbox has not been initialized.

-902 nameTypeErr Invalid or inappropriate locationKindSelector in
locationName.

-903 noPortErr Invalid port name. Unable to open port or bad portRefNum.

-904 | noGlobalsErr The system is unable to allocate memory. This is a critical
error, and you should restart.

-905 localOnlyErr Network activity is currently disabled.

-906 destPortErr Port does not exist at destination.

-907 sessTableErr PPC Toolbox is unable to create a session.

-908 noSessionErr Invalid session reference number.

-909 badReqErr Bad parameter or invalid state for this operation.

-910 | portNameExistsErr Another port is already open with this name (perhaps in
another application).
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Table B-1.  PPC Error Codes (Continued)

Code Name Description

911 noUserNameErr User name unknown on destination machine.

912 userRejectErr Destination rejected the session request.

-913 noMachineNameErr User has not named his Macintosh in the Network Setup
Control Panel.

914 noToolboxNameErr A system resource is missing.

-915 | noResponseErr Unable to contact destination application.

916 portClosedErr The port was closed.

-917 sessClosedErr The session has closed.

919 badPortNameErr PPCPortRec is invalid.

-922 noDefaultUserErr User has not specified owner name in Sharing Setup Control
Panel.

-923 notLoggedInErr The default userRefNum does not yet exist.

-924 noUserRefErr Unable to create a new userRefNum.

-925 networkErr An error has occurred in the network.

-926 nolnformErr PPCStart failed because destination did not have an inform
pending.

-927 authFailErr User’s password is wrong.

-928 noUserRecErr Invalid user reference number.

-930 badServiceMethodErr | Service method is other than ppcServiceRealTime.

-931 badLocNameErr Location name is invalid.

-932 guestNotAllowedErr Destination port requires authentication.
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AppleEvent Error Codes

The following table lists AppleEvent error codes and their
descriptions. Error codes -1700 through -1707 are most likely to be
returned by the AESend VI. Error messages -1708 through -1719 are
usually in response to sending or receiving a message. See Table B-5
of this appendix for LabVIEW Specific AppleEvent Error Codes.

Appendix B Error Codes

Table B-2.  AppleEvent Error Codes
Code Name Description
-1700 | errAECoercionFail Data could not be coerced to the requested descriptor
type.
-1701 | errAEDescNotFound Descriptor record was not found.
-1702 | errAECorruptData Data in an Apple event could not be read.
-1703 | errAEWrongDataType Wrong descriptor type.
-1704 | errAENotAEDesc Not a valid descriptor record.
-1705 | errAEBadListltem Operation involving a list item failed.
-1706 | errAENewerVersion Need a newer version of AppleEvent Manager.
-1707 | errAENotAppleEvent The event is not an Apple event.
-1708 | errAEReplyNotValid AEResetTimer was passed an invalid reply parameter.
-1709 | errAEERReplyNotValid AEResetTimer was passed an invalid reply parameter.
-1710 | errAEUnknownSendMode Invalid sending mode was passed.
-1711 | errAEWaitcanceled User canceled out of wait loop for reply or receipt.
-1712 | errAETimeout Apple event timed out.
-1713 | errAENoUserInteraction No user interaction allowed.
-1714 | errAENotASpecialFunction Wrong keyword for a special function.
-1715 | errAEParamMissed Handler did not get all required parameters.
-1716 | errAEUnknownAddressType | Unknown Apple event address type.
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Table B-2.  AppleEvent Error Codes (Continued)

Code Name Description

-1717 | errAEHandlerNotFound No handler in the dispatch tables fits the parameters to
AEGetEventHandler or AEGetCoercionHandler.

-1718 | errAEReplyNotArrived The contents of the reply you are accessing have not
arrived yet.

-1719 | errAElllegallndex Index is out of range in a put operation.

LabVIEW Specific PPC Error Codes

The following table lists the LabVIEW specific PPC error codes and
their descriptions. Errors that PPC VIs return with a positive value are
LabVIEW specific PPC errors, and are listed in Table B-3 below.
Errors that PPC VIs return with negative values are Macintosh
Toolbox errors. See Table B-1 of this appendix for a listing of the
Macintosh Toolbox PPC Error Codes.

Table B-3. LabVIEW Specific PPC Error Codes

Code Name Description

1 errNoPPCToolBox The PPC ToolBox either does not exist (it requires System 7.0
or later) or it could not be initialized.

2 errNoGlobals The CIN in the PPC VI could not get its globals.

3 errTimedOut The PPC operation exceeded its timeout limit.

4 errAuthRequired The target specified in the PPC Start Session VI required
authentication, but the authentication dialog was not allowed.

5 errbadState The PPC Start Session VI found itself in an unexpected state.
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Appendix B Error Codes

The following table lists TCP and UDP error codes and their

descriptions.
Table B-4. TCP and UDP Error Codes
Code Name Description

53 mgNotSupported LabVIEW Manager call not
supported.

54 ncBadAddressErr The net address was ill formed.

55 nclnProgressErr Operation is in progress.

56 ncTimeOutErr Operation exceeded the user-
specified time limit.

57 ncBusyErr The connection was busy.

58 ncNotSupportedErr Function not supported.

59 ncNetErr The network is down,
unreachable, or has been reset.

60 ncAddrInUseErr The specified address is currently
in use.

61 ncSysOutOfMemErr System could not allocate
necessary memory.

62 ncSysConnAbortedErr System caused connection to be
aborted.

63 ncConnRefusedErr Connection is not established.

65 ncAlreadyConnectedErr | Connection is already
established.

66 ncConnClosedErr Connection was closed by peer.
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LabVIEW Specific Error Codes for AppleEvent Messages

The following table lists LabVIEW specific error codes in response to
AppleEvent Messages and their descriptions. See Table B-2 of this
appendix for AppleEvent Error Codes that are not LabVIEW specific.

Table B-5.  LabVIEW Specific Error Codes for AppleEvent Messages

Code Name Description

1000 kLVE_InvalidState | The VI is in a state that does not allow it to run.

1001 kLVE_FPNotOpen | The VI front panel is not open.

1002 kLVE_CtrlErr The VI has controls on its front panel that are in
an error state.

1003 kLVE_VIBad The VI is broken.

1004 kLVE_NotInMem The VI is not in memory.

DDE Error Codes
The following table lists DDE error codes and their descriptions.
Table B-6.  DDE Error Codes

Code Name Description

00000 No error.

14001 | DDE_INVALID_REFNUM Invalid refnum.

14002 | DDE_INVALID_STRING Invalid string.

14003 | DDEML_ADVACKTIMEOUT Request for a synchronous advise transaction
has timed out.

14004 | DDEML_BUSY Response set the DDE_FBUSY bit.

14005 | DDEML_DATAACKTIMEOUT Request for a synchronous data transaction
has timed out.
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Table B-6.  DDE Error Codes (Continued)

Code Name Description

14006 | DDEML_DDL_NOT_INITIALIZED DDEML called without first calling
DdeInitialize,orwaspassedaninvalid
instance identifier.

14007 | DDEML_DLL_USAGE A monitor or client-only application has
attempted a DDE transaction.

14008 | DDEML_EXECACKTIMEOUT Request for a synchronous execute
transaction has timed out.

14009 | DDEML_INVALIDPARAMETER Parameter not validated by the DDML.

14010 | DDEML_LOW_MEMORY Server application has outrun client,
consuming large amounts of memory.

14011 | DDEML_MEMORY_ERROR A memory allocation failed.

14012 | DDEML_NOTPROCESSED Request or poke is for an invalid item.

14013 | DDEML_NO_CONV_ESTABLISHED Client conversation attempt failed.

14014 | DDEML_POKEACTIMEOUT Transaction failed.

14015 | DDEML_POSTMSG_FAILED Request for a synchronous poke transaction
has timed out.

14016 | DDEML_REENTRANCY An application with a synchronous
transaction in progress attempted to initiate
another transaction, or a DDEML callback
function called DdeEnableCallback.

14017 | DDEML_SERVER_DIED Server-side transaction attempted on
conversation terminated by client, or service
terminated before completing a transaction.

14018 | DDEML_SYS_ERROR Internal error in the DDMEML.

14019 | DDEML_UNADVACKTIMEOUT Request to end advise has timed out.

14020 | DDEML_UNFOUND_QUEUE_ID Invalid transaction identifier passed to

DDEML function.
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessary
to help us solve your technical problems and a form you can use to comment on the product
documentation. When you contact us, we need the information on the Technical Support Form
and the configuration form, if your manual contains one, about your system configuration to
answer your questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
quickly provide the information you need. Our electronic services include a bulletin board
service, an FTP site, a FaxBack system, and e-mail support. If you have a hardware or software
problem, first try the electronic support systems. If the information available on these systems
does not answer your questions, we offer fax and telephone support through our technical support
centers, which are staffed by applications engineers.

Electronic Services

Bulletin Board Support

National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
files and documents to answer most common customer questions. From these sites, you can also
download the latest instrument drivers, updates, and example programs. For recorded
instructions on how to use the bulletin board and FTP services and for BBS automated
information, call (512) 795-6990. You can access these services at:

United States: (512) 794-5422 or (800) 327-3077
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom: (44) 635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France: (1) 48 651559
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support

To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use
your Internet address, such as joesmith@anywhere. com, as your password. The support
files and documents are located in the /support directories.
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FaxBack Support

FaxBack is a 24-hour information retrieval system containing a library of documents on a wide
range of technical information. You can access FaxBack from a touch-tone telephone at the

following numbers:

(512) 418-1111 or (800) 329-7177

E-Mail Support (currently U.S. only)

You can submit technical support questions to the appropriate applications engineering team
through e-mail at the Internet addresses listed below. Remember to include your name, address,
and phone number so we can contact you with solutions and suggestions.

GPIB: gpib.support@natinst.com
DAQ: dag.support@natinst.com

VXI: vxi.support@natinst.com
LabWindows: 1lw.support@natinst.com

Fax and Telephone Support

National Instruments has branch offices all over the world. Use the list below to find the
technical support number for your country. If there is no National Instruments office in your
country, contact the source from which you purchased your software to obtain support.

Australia
Austria
Belgium
Canada (Ontario)
Canada (Quebec)
Denmark
Finland
France
Germany
Hong Kong
Italy

Japan
Korea
Mexico
Netherlands
Norway
Singapore
Spain
Sweden
Switzerland
Taiwan
U.K.

Telephone

9
03 9 879 9422

06624579900
02 757 00 20
519 622 9310
514 694 8521
4576 26 00
90 527 2321
148 142424
089 741 31 30
2645 3186

02 48301892
03 5472 2970
02 596 7456
95 800 010 0793
0348 433466
32 84 84 00
2265886

91 640 0085
08 730 49 70
056 200 51 51
02 377 1200
01635 523545

LabVIEW: 1v.support@natinst.com
HiQ: hiqg.support@natinst.com
VISA: visa.support@natinst.com

Fax

—]
0398799179

0662 45 79 90 19
027570311
519 622 9311
514 694 4399
457671 11
90 502 2930
148 1424 14
089 714 60 35
2686 8505

02 48301915
03 5472 2977
02 596 7455
5520 3282
0348 430673
32 84 86 00
2265887

91 640 0533
08 730 43 70
056 200 51 55
02 737 4644
01635 523154



Technical Support Form

Photocopy this form and update it each time you make changes to your software or hardware, and
use the completed copy of this form as a reference for your current configuration. Completing
this form accurately before contacting National Instruments for technical support helps our
applications engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem,
include the configuration forms from their user manuals. Include additional pages if necessary.

Name

Company

Address

Fax (__ ) Phone (___)

Computer brand Model Processor

Operating system (include version number)

Clock speed MHz RAM MB Display adapter
Mouse ___yes ___no Other adapters installed
Hard disk capacity MB Brand

Instruments used

National Instruments hardware product model Revision

Configuration

National Instruments software product Version

Configuration

The problem is:

List any error messages:

The following steps reproduce the problem:




Documentation Comment Form

National Instruments encourages you to comment on the documentation supplied with our
products. This information helps us provide quality products to meet your needs.

Title: LabVIEW® Communications VI Reference Manual
Edition Date: November 1995
Part Number: 320587C-01

Please comment on the completeness, clarity, and organization of the manual.

If you find errors in the manual, please record the page numbers and describe the errors.

Thank you for your help.

Name

Title

Company

Address

Phone ()

Mail to: Technical Publications Faxto: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway (512) 794-5678

Austin, TX 78730-5039



Prefix Meaning Value
n- nano- 10"
u- micro- 10°
m- milli- 10°
k- kilo- 10°
M- mega- 10°
Numbers/Symbols

A

abort

ANSI
APDA
array
ASCII

asynchronous execution

© National Instruments Corporation

The procedure that terminates a program when a mistake,
malfunction, or error occurs.

American National Standards Institute.

Apple Programmer Developer Association.

Ordered, indexed set of data elements of the same type.
American Standard Code for Information Interchange.
Mode in which multiple processes share processor time. For

example, one executes while the others wait for interrupts, as
while performing device I/O or waiting for a clock tick.
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CIN
client

cluster

connection ID

control

D

DARPA

datagram

DDE
dialog box

dotted decimal notation

driver

E

Code Interface Node. Special block diagram node through which
you can link conventional, text-based code to a VI.

The application that sends or calls messages from the server
application in a dynamic data exchange.

A set of ordered, unindexed data elements of any data type
including numeric, Boolean, string, array, or cluster. The
elements must be all controls or all indicators.

A unique identification of a connection that you use for reference
in subsequent VI calls.

Front panel object for entering data into a VI interactively or into
a subVI programmatically.

Defense Advanced Research Projects Agency.

IP-packaged data components that contain, among other things,
the data and a header that indicates the source and destination
addresses.

Dynamic Data Exchange. A client-controlled Windows protocol
for communication between applications.

An interactive screen with prompts in which the user specifies
additional information needed to complete a command.

A method of describing a 32-bit internet address in which the
address is divided into four 8-bit binary numbers and written as
four integers separated by decimal points.

Software used to manipulate a device or interface board.

ethernet A network system that carries audio and video information as
well as computer data.
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H

handler

IAC

icon

IEEE
indicator
internet
internetwork

Ip

L

LabVIEW
LF

MB

NaN

© National Instruments Corporation

Glossary

A device driver installed as part of the operating system of the
computer.

Interapplication Communication. A feature of Apple Macintosh
system software version 7 by which applications can
communicate with each other.

Graphical representation of a node on a block diagram.
Institute of Electrical and Electronic Engineers.

Front panel object that displays output.

See internetwork.

Single or interconnected networks.

Internet Protocol. Protocol that performs the low-level service of
packaging data into components (datagrams). See TCP/IP.

Laboratory Virtual Instrument Engineering Workbench.

Line feed.

Megabytes of memory.

Digital display value for a floating-point representation of not a
number, typically the result of an undefined operation, such as
log(-1).
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0

OLE

OLE Automation

P

palette

PC

poke
PPC

protocol

R

refnum

remote address

S

SCSI
sec

server
spreadsheet

string

Object Linking and Embedding.

A feature which allows LabVIEW to access objects by
automation servers in the system.

A collection of function or control icons from which you can
select the control or function you need.

Personal Computer. Used to refer to IBM-compatible computers.

An instruction that places a value into a specific location in
memory.

Program-to-Program Communication. A low-level form of IAC
by which applications send and receive blocks of data.

Set of rules or conventions that cover the exchange of
information between computer systems.

An identifier of a DDE conversation or open files that can be
referenced by related VlIs.

Address of the remote machine associated with a connection.

Small Computer System Interface (bus).
Seconds.

The application that receives messages from the client
application in a dynamic data exchange.

Any of a number of programs that arrange data and formulas in a
matrix of cells.

A connected sequence of characters or bits treated as a single data
item.
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T

TCP
TCP/IP

timeout

U

uDP

utility

VI

wire
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Glossary

Transmission Control Protocol. See TCP/IP.

Transmission Control Protocol/Internet Protocol. A suite of
communications protocols that you use to transfer blocks of data
between applications.

The time (in milliseconds) that a VI waits for an operation to

complete. Generally, a timeout of -1 causes a VI to wait
indefinitely.

User Datagram Protocol. See TCP/IP.

A program that helps the user run, enhance, create, or analyze
other programs and systems.

Virtual instrument. LabVIEW program; so called because it
models the appearance and function of a physical instrument.

Data path between nodes.

G-5 LabVIEW Communications VI Reference Manual



A

abnormal port closings. See Close All PPC
Ports VI.

Abort VI AppleEvent. See AESend Abort VI.
addresses, Internet, 1-7 to 1-8
advise, DDE, 4-2
AECreate Comp Descriptor VI, 6-28 to 6-29
AECreate Descriptor List VI, 6-32
AECreate Logical Descriptor VI, 6-29
AECreate Object Specifier VI, 6-30 to 6-31
AECreate Range Descriptor VI, 6-31
AECreate Record VI, 6-32 to 6-33
AESend Abort VI, 6-16 to 6-17
AESend Close VI, 6-17
AESend Do Script VI, 6-11
AESend Finder Open VI

description, 6-11 to 6-12

launching applications, 1-23 to 1-24

launching applications remotely, 7-2

opening applications, 6-4
AESend Open Document VI, 6-13 to 6-14
AESend Open VI, 6-12 to 6-13
AESend Open, Run, Close VI

description, 6-18

dynamically loading and running

VIs, 1-25

AESend Print Document VI, 6-14 to 6-15
AESend Quit Application VI, 6-15
AESend Run VI, 6-18
AESend VI

description, 6-25 to 6-26

when to use, 6-4
AESend VI Active?, 6-19
AppleEvent VIs

compared with Program to Program
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Communication VIs, 6-5
dynamically loading and running
VIs, 1-25
general behavior, 6-4 to 6-7
getting help, 6-2
LabVIEW-specific AppleEvent VIs
AESend Abort VI, 6-16 to 6-17
AESend Close VI, 6-17
AESend Open, Run, Close VI, 6-18
AESend Run VI, 6-18
AESend VI Active?, 6-19
low-level
AESend, 6-4, 6-25 to 6-26
Make Alias, 6-27 to 6-28
object support
AECreate Comp Descriptor, 6-28
to 6-29
AECreate Logical Descriptor, 6-29
AECreate Object Specifier, 6-30
to 6-31
AECreate Range Descriptor, 6-31
example, 6-33 to 6-36
object support, low-level
AECreate Descriptor List, 6-32
AECreate Record, 6-32 to 6-33
sending options, 6-6 to 6-7
standard AppleEvent VIs
AESend Do Script VI, 6-11
AESend Finder Open VI, 6-11 to
6-12,7-2
AESend Open Document VI, 6-13
to 6-14
AESend Open VI, 6-12 to 6-13
AESend Print Document VI, 6-14
to 6-15
AESend Quit Application VI, 6-15
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Index

target ID, 6-5 to 6-6
targeting VIs
Get Target ID, 1-24, 6-6, 6-8 to 6-9
PPC Browser, 1-24, 6-5, 6-9 to 6-10
User Identity Dialog Box, 6-4 to 6-5
Users & Groups control panel utility, 6-4
AppleEvents, 1-22 to 1-25
advanced topics, 6-20 to 6-24
client examples, 1-23 to 1-25
dynamically loading and running
Vs, 1-25
launching applications, 1-23 to 1-24
sending events to other applications,
1-24 to 1-25
client/server model, 1-23
Close Application, 6-3
closing Finder, A-6
compared with Program to Program
Communication (PPC), 6-1, 7-2
constructing and sending, 6-20
creating AppleEvent parameters, 6-20
to 6-21
descriptor string formats (table), 6-22
to 6-23
using object specifiers, 6-28
definition, 1-22, 6-1
error codes, B-3 to B-4
LabVIEW-specific, B-4
LabVIEW software support, 6-1
Open Document, 6-3
Print Document, 6-3
purpose and use, 6-3
sending AppleEvents to LabVIEW from
other applications, 6-36 to 6-40
LabVIEW-specific
AppleEvents, 6-36
replies to AppleEvents, 6-37 to 6-40
Event:Abort VI, 6-38 to 6-39
Event:Close VI, 6-40
Event:Run VI, 6-37 to 6-38
Event: VI Active?, 6-39
required AppleEvents, 6-36
specifying target application, 6-4
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targeting VIs, 6-8 to 6-9
User Identity Dialog Box, 6-4 to 6-5
Users & Groups control panel utility, 6-4
vocabulary, 6-1
words, 6-1
AppleEvents VI palette, 6-2
applications, launching from LabVIEW, A-2
array of clusters symbol, xiv
array of double-precision floating-point
numbers, symbol for, xiv
array of signed 16-bit integers, symbol
for, xiv
array of unsigned 8-bit integers, symbol
for, xiv
authentication (password) mechanism, PPC
Vs, 6-5

Boolean symbol, xiii

C

client
AppleEvents client examples, 1-23
to 1-25
dynamically loading and running
VIs, 1-25
launching applications, 1-23 to 1-24
sending events to other applications,
1-24 to 1-25
DDE capabilities, 4-2 to 4-3
PPC, 7-2
example, 1-27 to 1-28
TCP example, 1-9
client/server model
AppleEvents, 1-23
client model, 1-3 to 1-4
overview, 1-3
server model, 1-5 to 1-6
Close All PPC Ports VI, 7-6
Close VI AppleEvent. See AESend Close VI.
cluster symbol, xiii
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communication
client/server model, 1-3 to 1-4
communication protocols, 1-1 to 1-2
definition, 1-1
communication protocols. See AppleEvents;
DDE (Dynamic Data Exchange); PPC
(Program to Program Communication);
TCP/IP protocol; UDP (User Datagram
Protocol).
conversation refnum, DDE (caution), 4-3
customer communication, xv, C-1

D

DARPA (Defense Advanced Research
Projects Agency), 1-6
data type symbols, xiii to xiv
datagrams. See also UDP (User Datagram
Protocol).
definition, 2-2
sent by Internet Protocol (IP), 1-7
DDE (Dynamic Data Exchange), 1-11 to 1-22
calling Excel macros, A-3
client capability, 4-2 to 4-3
client communication with Excel
(example), 1-13 to 1-14
communicating with non-LabVIEW
applications, A-4
DDE Poke problems, A-3 to A-4
definition, 1-11
error codes, B-6 to B-7
LabVIEW VIs as DDE servers, 1-15
to 1-16
netDDE
client machine, 4-6
Windows 95, 4-5 to 4-6
Windows for Workgroups, 4-5
Windows NT, 4-6
netDDE, using with LabVIEW, 4-4 to 4-7
networked DDE, 1-21 to 1-22
overview, 1-11 to 1-12
requesting data vs. advising data, 1-17
to 1-18
server capability, 4-4
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services, topics, and data Items, 1-12
to 1-13
synchronization of data, 1-18 to 1-21
DDE VIs
DDE Advise Check
avoiding data duplication, 1-18
description, 4-7 to 4-8
returning data value, 4-3
DDE Adyvise Start
avoiding data duplication, 1-18
creating local copy of data
value, 4-3
description, 4-8
DDE Advise Stop
avoiding data duplication, 1-18
description, 4-9
stopping all advises, 4-3
DDE Close Conversation
closing all conversations, 4-3
description, 4-10
DDE Execute, 4-10
DDE Open Conversation
description, 4-11
establishing conversation, 4-2
DDE Poke
description, 4-11 to 4-12
problems with Microsoft Access,
A-3to A-4
DDE Request
description, 4-12 to 4-13
retrieving data, 1-17
sending message to server, 4-3
DDE Srv Check Item
description, 4-13 to 4-14
monitoring pokes, 4-4
DDE Srv Register Item, 4-14
DDE Srv Register Service
description, 4-15
specifying service name and
topic, 4-4
DDE Srv Set Item
changing value of items, 4-4
description, 4-16
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DDE Srv Unregister Item
closing down DDE server, 4-4
description, 4-16
DDE Srv Unregister Service
closing down DDE server, 4-4
description, 4-17
getting help, 4-1
Defense Advanced Research Projects Agency
(DARPA), 1-6
documentation
conventions, xii to xiv
organization, xi to xii
related documentation, xiv
double-precision floating-point number,
symbol for, xiii
Dynamic Data Exchange (DDE). See DDE
(Dynamic Data Exchange).
Dynamic Data Exchange VI palette, 4-1

E

error codes
AppleEvents error codes, B-3 to B-4
Dynamic Data Exchange (DDE), B-6
to B-7
LabVIEW-specific AppleEvent error
codes, B-6
LabVIEW-specific PPC error codes, B-4
PPC, B-1 to B-2
TCP and UDP error codes, B-5
TCP/1P, 2-5
errors. See also specific VIs.
TCP VIs, 2-5
UDP VIs, 3-3
Excel
calling Excel macros, A-3
DDE example, 1-13 to 1-14

F

file sharing networks vs. communication
protocol, 1-3
Finder, closing, A-6
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Functions palette
Communication palette

AppleEvents VI palette, 6-2
DDE VI palette, 4-1
OLE Automation VIs palette, 5-1
PPC VI palette, 7-1
TCP/IP VI palette, 2-1
UDP palette, 3-1

G

Get Target ID
creating target ID, 1-24, 6-6
description, 6-8 to 6-9
searching entire network, zone, and
server (table), 6-9

H

Hewlett-Packard workstations, support for
TCP/1P, 1-8

host files, 1-8

hostname resolution, 1-8

IAC. interapplication communication (IAC)
interapplication communication (IAC). See
also AppleEvents.
definition, 6-1
LabVIEW software support, 6-1
PPC low-level form of, 7-1
System 7 requirements, 6-2
User Identity Dialog Box, 6-4 to 6-5
Internet addresses, 1-7 to 1-8
Internet Protocol (IP). See also TCP/IP
protocol.
compared with other protocols, 1-7
purpose and use, 2-2
IP To String VI, 2-5
IP. See Internet Protocol (IP).
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L

LabVIEW software
built-in networking protocols, 1-2
communicating with other applications
Macintosh, A-1
Sun and HP-UX, A-1
Windows, A-1
installing shared application, A-4 to A-5
interapplication communication (IAC)
support, 6-1
sending AppleEvents, 6-4
support for AppleEvents, 6-1
supporting OLE, A-5
TCP/IP support, 1-9
LabVIEW-specific AppleEvent VIs. See
AppleEvent VlIs.
launch another application with
LabVIEW, A-2

Macintosh applications
communicating with LabVIEW, A-1
Macintosh computers, support for TCP/IP, 1-8
Macintosh protocols. See AppleEvents; PPC
(Program to Program Communication).
Make Alias VI, 6-27 to 6-28
manual. See documentation.

net DDE, using with LabVIEW, 4-4 to 4-7
Communication palette

AppleEvents VI palette, 6-2

DDE VI palette, 4-1

OLE Automation VIs palette, 5-1

PPC VI palette, 7-1

TCP/IP palette, 2-1

UDP palette, 3-1
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0

Object Linking and Embedding. See OLE.
OLE, 5-2
LabVIEW support, A-5
OLE automation clients/controllers, 5-2
OLE automation servers, 5-2
OLE Automation VIs
Create Automation Refnum, 5-3 to 5-4
Execute Method, 5-4 to 5-5
Get Property, 5-5
List Methods or Properties, 5-6
List Objects in Type Library, 5-6 to 5-7
Release Refnum, 5-7
Set Property, 5-8
OLE Automation VIs palette, 5-1

P

parameters, AppleEvent
creating, 6-20 to 6-21
using object specifiers, 6-28
descriptor string formats (table), 6-22
to 6-24
password (authentication) mechanism, PPC
Vlis, 6-5
path symbol, xiii
port reference number
using TCP and UDP, A-2
ports
Program to Program Communication
(PPC)
multiple ports and multiple sessions,
7-2to 7-3
opening, 7-2 to 7-3
port reference number, 7-2
purpose and use, 1-26 to 1-27
PPC (Program to Program Communication)
authentication (password)
mechanism, 7-3
client, 7-2
client example, 1-27 to 1-28
closing ports, 7-3
compared with AppleEvents, 6-1
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definition, 1-26, 6-1

error codes
LabVIEW-specific, B-6

general behavior, 7-2 to 7-4

PPC VIexecution order (illustration),

7-4
initiating sessions, 7-3
LabVIEW software support, 6-1
limitations, 7-2

multiple ports and multiple sessions, 7-2

to 7-3

opening ports, 7-2 to 7-3

overview, 1-26

port reference number, 7-2

ports, target IDs, and sessions, 1-26
to 1-27

receiving session requests, 7-3

server, 7-2

server example, 1-28 to 1-29

server with multiple connections, 1-29

session reference number, 7-3

PPC VI palette, 7-1

PPC VIs
Close All PPC Ports VI, 7-6
compared with AppleEvent Vs, 6-5
general behavior, 7-2 to 7-4

execution order (illustration), 7-4

getting help, 7-1

guest access on remote computer, 6-4

PPC Accept Session, 7-5
PPC Browser
creating target ID, 1-24, 6-5
description, 6-9 to 6-10
problems connecting
applications, A-6
PPC Close Connection
PPC client example, 1-28
PPC Close Port
closing ports, 7-3
description, 7-6
PPC server example, 1-29
PPC Close Session
PPC client example, 1-28
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PPC server example, 1-29
PPC End Session

description, 7-7

ending sessions, 7-3
PPC Inform Session

description, 7-7 to 7-8

PPC server example, 1-28

receiving session requests, 7-3
PPC Open Port

description, 7-9 to 7-10

opening ports, 1-26, 7-2

PPC server example, 1-28
PPC Open Session

PPC client example, 1-27
PPC Read

communicating with other

applications, 7-3

description, 7-11, 7-12

PPC client example, 1-27
PPC Start Session

description, 7-12

initiating PPC sessions, 7-3

PPC client example, 1-27
PPC Write

description, 7-13

PPC client example, 1-27

PPC server example, 1-29
unauthenticated sessions, 6-5

Program to Program Communication (PPC).
See PPC (Program to Program
Communication).

Program to Program Communication VIs.
See PPC Vls.

protocol

communication protocols, 1-1 to 1-2
definition, 1-1
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refnum
DDE conversation refnum (caution), 4-3
symbol for, xiii

replies to AppleEvents, 6-37 to 6-40
Event:Abort VI, 6-38 to 6-39
Event:Close VI, 6-40
Event:Run VI, 6-37 to 6-38
Event:VI Active?, 6-39

request, DDE, 4-2

S

send options, AppleEvent VIs, 6-6 to 6-7
definition, 6-6
illustration, 6-6
parameters, 6-6 to 6-7
servers. See also client/server model.
DDE capabilities, 4-4
LabVIEW VIs as DDE servers, 1-15
to 1-16
PPC example, 1-28 to 1-29
Program to Program Communication
(PPC), 7-2
TCP example, 1-10 to 1-11
TCP server with multiple
connections, 1-11
service, DDE, 1-12
session reference number, PPC, 7-3
signed 16-Bit integer symbol, xiii
signed 32-bit integer symbol, xiii
standard AppleEvent VIs. See
AppleEvent VIs.
string array symbol, xiv
string symbol, xiii
String To IP VI, 2-5 to 2-6
strings, AppleEvent. See parameters,
AppleEvent.
Sun and HP-UX applications
communicating with LabVIEW, A-1
Sun workstations, support for TCP/IP, 1-8
Synch DDE Client / Server, A-5
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T

target ID
definition, 6-5
generating, 1-24, 6-5
questions about, A-5 to A-6
specifying for PPC client, 1-27
targeting VIs
Get Target ID, 1-24, 6-6, 6-8 to 6-9
PPC Browser, 1-24, 6-5, 6-9 to 6-10
TCP, 2-3
TCP (Transmission Control Protocol). See
also TCP/IP protocol.
client example, 1-9
compared with PPC, 1-26
compared with UDP, 1-9
establishing connections, 2-3
initiating connections, 2-3
purpose and use, 2-2 to 2-4
reliability, 2-2
server example, 1-10 to 1-11
server with multiple connections, 1-11
timeouts and errors, 1-10
waiting for connections, 2-3 to 2-4
TCP and UDP
error codes, B-5
TCP VI palette (illustration), 2-1
TCP VIs
errors, 2-5
getting help, 2-1
IP To String VI, 2-5
String To IP VI, 2-5 to 2-6
TCP Close Connection
closing a listener, 2-4
closing connection, 2-4
description, 2-6
to server (example), 1-10, 1-11
TCP Create Listener
description, 2-6 to 2-7
waiting for incoming
connection, 2-3
TCP Listen
description, 2-7 to 2-8
example, 1-11
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waiting for connection, 2-3
TCP Open Connection, 2-8 to 2-9
TCP Read

description, 2-9

reading results from server

(example), 1-10
TCP Wait on Listener, 2-10
TCP Write

description, 2-11

returning results (example), 1-11

sending command to server

(example), 1-10
TCP/IP protocol

compared with other protocols, 1-6 to 1-7

error codes, 2-5

Internet addresses, 1-7 to 1-8
purpose and use, 1-6 to 1-7
setup

LabVIEW software and TCP/IP, 1-9

Macintosh computers, 1-8
Sun and HP-UX, 1-8
TCP client example, 1-9

TCP server example, 1-10 to 1-11

TCP server with multiple
connections, 1-11

TCP vs. UDP, 1-9
timeouts and errors, 1-10
Windows 3.x environment, 1-8
Windows 95, 1-9
Windows NT, 1-9

technical support, C-1

timeouts, TCP, 1-10

topic, DDE, 1-12, 4-2

Transmission Control Protocol (TCP). See

TCP (Transmission Control Protocol).

u

UDP (User Datagram Protocol)
compared with TCP, 1-9
error codes, B-5
limitations, 3-2
purpose and use, 3-1 to 3-3

UDP VI palette, 3-1
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UDP VIs
errors, 3-3
getting help, 3-1
UDP Close, 3-3
UDP Open
creating connections, 3-2
description, 3-3 to 3-4
UDP Read
description, 3-4 to 3-5
preservation of packet
boundaries, 3-2
UDP Write
description, 3-5 to 3-6
sending data to destination, 3-2
unsigned 16-bit integer symbol, xiii
unsigned 32-bit integer symbol, xiii
User Datagram protocol (UDP). See UDP
(user Datagram Protocol).
User Identity Dialog Box, 6-4 to 6-5
Users & Groups control panel utility, 6-4

v

vocabulary, in AppleEvents, 6-1

]

Windows 3.x environment. See also DDE
(Dynamic Data Exchange); DDE VIs.
setting up for TCP/IP, 1-8
Windows 95
support for TCP/IP, 1-9
Windows applications
communicating with LabVIEW, A-1
Windows NT
support for TCP/IP, 1-9
Winsock DLLs, 1-8, A-2
words, in AppleEvents, 6-1
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